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DOCYMMWER OF DJ'S

This project has to do with the work of a DJ whislone of the most misunderstanding
jobs that a young person can do in our days. Mpie bf employment, is really needed in
daily life of each city and especially of Thess@omvhich is extremely famous for her

different and numerous ways of amusement. The mativation is the process of the

digital montage which has various steps and basaraptions and the general goal of it
is the acquisition of experience in producing audival videos and editing them.

The most important thing is to make everyone urtdeds the terminology and the basic
object of music technology. This fact takes plaeeduse of the documentary in which
the whole role of a DJ is presented and is alssgmted the place where he works.
Through this movie, the viewer is able to realize &dvantages and the disadvantages of
this type of employment. The multimedia that aredjsprovoke the interest of the
viewers as long as they combine image, sound aclthtdéogy and they are really
attractive to a wide range of people.

The most remarkable parts of the creation and tleeessing of the stuff are the

calculating systems of multimedia. These systerassaparated into two sorts. An other
noticeable part is the montage with which the wHibhe process is completed. Finally, is

given to the creator the opportunity to work ot &iuff in the best way that he can do it
in order to present to the viewers an impressieetsgle.



KE®AAAIO 1

1.11lepianyn

‘Eva a6 to mo mapeEnynuéva aALd TouTdYpOovVa 0o T TO GVYYPOVO EMAYYEALOTO OTN
xdpo pog givar avtd tov Dj, 0 0moiog pEc® TV HOVGIKOV ETAOYOV TOV Tpoomadel va
YUYOY®YNOEL OGOV TO dVVATOV TEPICCOTEPO TO KOO TOV. To emdyyeAio ovtd GLVOVTA
T1G O1kéG TOL duokoAieg KaBMG o1 cuvONKeg epyaciog dev elvar Ot WAVIKOTEPES Yo OO0V
10 exterel. AQopun AOmoOV Yo v Yvopicel KOAOTEPA TO €VPY KOWO OVTO TOV KAADO
oTaONKe 1 GLYYPAPN TNG SVYKEKPUEVNS epyacias. H Oeccaiovikn wg n kateEoynv mo
ONUOPIANG TOAN GTN VUYTEPIVI] SLAOKEDAOT) OMOTEAEL TO EMIKEVTPO Y10l VO SLOUOPPADCEL
Kavelg o caen ewova. Bivieo, anoondopata and v voytepv) {on Kot cuvevtedéelg
amd EMOyYEAUATIEG TOV Y®POV, Ol omoiot ekBéTovv TNV SN TOLG Amoym, extifevton
TOPOKATO OOTE VO GUUPAAOVY GTNV KOAVTEPT TPOGEYYIoN TOL OENHATOG.

1.2 Kivntpo mtroylokng

Mo amd TG GNUOVTIKOTEPES KoL O OVGLUOTIKEG SlodIKaGies ival VT TOL YNELIKOY
povtal, n omoia amotelel kol To kivntpo g epyaciag. H dwdikacio cuvnbmg Eekivaet
[e TV vAomoinorm evog mPOYEpoL pHovtdl pe amoomdopato (Video) younAing apykd
TOWOTNTOG YO VO EMTOYOVUE UEYOADTEPN TOLTNTO EMECEPYONGIOG KOl OTNV GLVEXELN
TparypoTromoteitol To TeEMkd povtal pe arocnacpoato (Video)vynidtepng motdtrog.
Amapaitnm npotndOeon etvar n xpnon Hog amAng ynelokng Kapepog kot 1 fondeia tov
KOTAAANAOL TTPOYPALLUOTOG.

[opokdto Aowmwdv mapovcidlovtor otadiokd to frpata, To onoio. akolovdndnkay yo
v enitevén 10V cLYKEKPIUEVOL LAKOV o popen DVD kor akoiovBdvtag o kabévag
v 101 dadikacio Bo £xel v duvatdTNTa dMovpYiag Kot enelepyaciog Tov d1Koy Tov
VAKOD.

0 Xpnon Pvteokauepag pe v Pondeio evog tpimoda yioo TV EYYpOn|
oTafePOTEPMV KOl GOCTOTEPMOV TAAVDV.

0 Koartaypaen kot amodrkevon tov VAMKoOL 6€ oKANPO dicko.

0 Xpnon tov mpoypappotog Ediusbapoxeipévov va viomombei n elcaymyn
Kot enegepyacio TOL AmapaiTNTov VAIKOD GTOV TPOCMOMIKO LITOAOYIOTN
(omv ayopd vmapyovv dSabioiueg ko vedtepeg ekddoelg tov Edius 5
kaBwg emiong Kot GAAa KatdAANAa wpoypdupata eneEepyocioc Pivteo,
gkdvag Kot Lovtal oe ynelokn Lopoen).



O ovykekpyévog tpémog povtal eivor avtd mov ovopdalovpe cvvibog Cut to Cut,
YPNOOTOIDOVTAG OUMG TOV LTOAOYIOTH) VWAPYEL GE OAOLG 1 OLVATOTNTO EVPECNG
TEPLOoOTEPOV Q€ Kol emeEepyaciog Oyl HOVO OTIC EIKOVES OALA Kol GTOV 1X0. AKOUO
UITOPOVUE VO OVOPEPOVUE TG EMTVUYYAVOVTOL KOAVTEPEG HETOPACELS OO TAAVO o€
TAGvo.

1.3 XKOTOG

O oKomdG ovTNG TG TTLYWKNG epyaciog eivar va amoktnOel gumepio ot mopoywyn
video, mov Ba meprloufdvel TNV KOTAYPAPT OTTIKONOVOTIKODL LAIKOL Kabd¢ kat tnv
ynolokn enefepyacio tov pécov oto Aoyiopkd Edius 5.Xta mlaicio g epyaciog
opdyOnKe ONTIKOOOVGTIKO LAIKO LE ¥pron

camcorder.Xtn ocvvégeln 0 VAIKO avtd Etvye emefepyocioa oe évo cvoTNUO U
ypappikng eneEepyaciog mote va 600gl To TeAKO anotédecpa og poper DVD. TNa

70 6KO0TO AT Ba YpMoIOTOMGOVE TANOD PO SLVOTOTITO®V TOL AOYIGUIKOD
eneEepyaciog Onms d10pHmaon Nyov, dvpbwon ypoudToV.



1.4 Aopn

H nmapayoyn video,nepirappaverl kvupiog 3 otddia :
A. TIpo-mapayoyn ( Pre-Production )
A@opd TV €yypapn Tov GEVOPIOL Kot TNV dnovpyio evog

YXPOVOILOY PALLOTOC Y10l TOL YOPIGHLOTOL.

B. IMapaywyn ( Production )
A@opd To yupiopaTo TOV CKNVAOV.

I'. Meta-napaywyn ( Post-Production )



KE®AAAIO 2

2.1 Emwokoénnon g 0smpiog

> Bewpnrtikn mpocEyyion tov BEpaTog Tapatifevtol S1ipopotl optopol Ko emtyelpeiTon
va 000l éva oteped BempnTIKO VTTOPAOPO YL OAES TIC EVVOLES TTOV AVOAVOVUE. € TPDOTN
eaon mapovctalovtor Pacikol oplopol TV TOWVIOV TEKUNPIOONG TNG HOVGIKNG
teyvoloylag Kot Tov emayyéAnatog tov Dj kot o ovrikeipevo evaoyOAnong Tovg e
TOPAYOYO OVTO TO VIOKVLUOVTEP. AVaADOVTOL TOAAG QVTIKEILEVO QLTS TNG KATNYOPlog
EVO GLYYPOVOS AVOADOVTOL 1] KAOUEPIVOTNTA KOt TO TPOPATLOTAL.

2.2 To avTIKEIPEVO GYEOLOONG VTOKVUAVTEP

[Mapovoialovtar o1 emIUDEEIS KAl 0L GTOYOL TOL VIOKLUOVTEP KOTA TNV dtodikacio TG
oyediaong tov. Ilpaypoatonoteiton o wpotdtLRn TOPpAy®YN KaBoTL otnv EAAGS0 dev
éxel yiver emayyelpotiky Ooviewd péypr otiyung. livetre emiong ovaeopd otnv
AELTOLPYIKOTNTO KOl OTO. EMUEPOVS YOPOKTINPLOTIKA TOV emayyéApotoc. H katavonon
TOV JPOPOV TPOTOV UEAETNG TOV EMAYYEALOTOS €lval PACIKY Yoo TNV €100Y®Y GTO
TEPLPAALOV TOV YOPOKTHP®V Ol 0TTOi0L CLUTEPIAOUBAVOVTOL LEGO GTNV Tovio. X€ YEVIKO
eminedo dwbétovror apykd mAdva mhve oto omoio PacilOLaoTE Yo VoL ELGAYOVUE TOV
Beatn oto KAipa, TOV €PyacloKkd y®PO, Kol Tov YeVIKO poro tov Dj péoca amd avtd mov
Kével. Xe €101k eminedo £0TIALOVUE TO EVOLAPEPOV OTNV KaBnueptvoOTNTA TOL PEGH O
TV UIKPoL pfKovg touvia 1 omola pog Oelyvel  ta BeTikd kol opvnTikd Kabdg Kot
TPLTOYEVEIG TAPAYOVTES 01 OO0 LTOPOVV VO, ETNPEAGOLV.

2.3 Xvoyétion oyediaong Kol vAomoinong Towviog

H vAomoinon tov vrokipavtép oyetiCetoan mpwtiotwg pe v oxediaon g Omwg kibe
TPOTOV TOV TOPAYETOL KOl SLAVEUETOL GTNV 0yopd .AvaAidovpe v onuacio Tov BEAeL va
pog 0MoeL M Touvio Yo TNV KOAOTEPN Yvopuio Kol exaen pe Tov Oeatn 6mov povo pe
My Bivieo emruyydvetal KAAVTEPT TPOGEYYIOT TOL AVTIKEILEVOD.

2.4 T'evika,

Ta molvpéoa eivor pio amd TG MO TOAVGLINTNUEVEG TEXVOAOYIEG TOV POV TNG
dexaetiag Tov 90.To evdlapépov avTd eival amdOAVTO SIKOOAOYNUEVO, OPOV TO TTOAVUECH
OTOTEAOVV TO ONUEID GLVAVINONG TEVTE PEYOA®V PLOUNYavVIdV: TNS TANPOPOPIKNG, TOV
TNAETKOWVOVIAV, TOV NAEKTPOVIK®OV €kdOGE®V, TG Prounyaviag audiokot video kabmg
Kot G Propumyaviag g TAEdpOoNS KOl TOL Kwvnuotoypdeov. Mio  avdioyn
OVOOTATOON EMEPEPE KOL 1) EUPAVIOT] TNG EMOTHUNG TOV OIKTH®V VITOAOYIOTOV OTN|



dexoetion Tov 70, EPVOVTOG TTO KOVTH TNV TANPOPOPIKN HE TIS TNAETIKOWV®VIEG. ALTA 1
TPOGEYYIOT 0ONYNOE GE TPOIOVION TOV GTOYELOAV KLPIWE GTNV AYOPd TV EMYEIPNCEWDV.
Ta molvpéca ékavayv KATL TEPICGOTEPO, OLEVPLVOV TNV OYOPE TMOV TPOIOVIOV TOV
ToPOTEVe Bropunyovidv mov TAEOV GTOYXEVOVV Kol 6TOVS Katavalwtés.H mAnfdpa kot ot
mowMo Tov vémv Tpoidviov kobmg Kot M mwpoomdbei  eKUETAAAELONG  TOL
EVOLAPEPOVTOG TTOV EMEDEIEE TO AYOPAOTIKO KOWO Yol TNV TEYVOAOYiOL T®V TOAVUECHOV
OGULVETEAEGAV GTNV GUYYVOT] TOL VILAPYEL AKOWA KOl CTLEPA OGOV
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aQopAd oTo T €lvar Kot Tt OV glval €va cLOTNHO TOAVPEG®OY. Mo KaAn apyr Yo Tov
KaBoplopd Tov Opov gival N avdAvon g ETLHOAOYING TOV.

2.5 Etoporoyia

O ayyAkog 6pog, Tov €dm £xel amodobel g molvpéoa, sivar multimedia.O 6pog avtog
amoteAgiton and dvo pépn: to Tpdbepa multi kot ™ pila media. Multi:tpoépyetan amd
™ Aotwvikny AEEN multus kot onuaivel "moAvdapipog”, "moAlamidg”. Media: sivor o
TnOuvTikdc apBuds g emiong Aotvikng Aééng medbl Tov onuaiver "uéco”, "kévrpo”.
Mo =mpoécpata n AéEn medin Gpyloe va ypnowuomoleitor kKot ®¢g "evolduecog”,
"necorafntc”’. Katd ocvvénela, o optoudc mov mpokvmtet givar: Multimedia onpaivel
"molamAol pecorapntéc” N "moAlamAd péca” Kot ypnolpuonolEiton €ite MG OLGLOGTIKO
elte ¢ enibero.

H npd mpocéyyion tov opiopod dev pog AEet kot ToAA Tpdypote. Mmopodue OGS vo
Tov PBedtidoovpe avoroyldpevol tov tpoémo ypnong tev opmv multi, kot media. O
ayyMkdc Opog media ypnoponotleitor o€ TOAAOVG  OWKOVOUIKOVG, TEYVIKODS Kot



EMOTNUOVIKOVS TOUELS e dlopopeTikég onpacies. To kowod onueio avT®OV TOV ¥PHCEDV
etvan 6T oyetilovran TAVTOTE e KATO0 £I00G XEPIOUOV TANPOPOPIOG:

- AmoOnkevon kot enelepyocio otV TANPOPOPIKN

- [Topaywyn otov ydpo TV EKOOGEWV

- Alavopn 6TeV YOPO TOV HALIKOV HEGMV ETIKOVOVING

- Metdooon oTig TNAETIKOWVOVIEG

- Avtiinyn katd v aAAnAeniopaon tov avBpaomov pe 1o TEPPAAAOV TOV.
Kotd ocvvéneio pmopovpe va eAtidcovpe Tov opiopd g eENG:

»llolvuéoa atov ywpo tis teyvoloyias minpopopias (information field) eyuaiver
" wollamloi pecolofntés”’ uETOED THS TNYHS KAl TOV TOPOANTTH THS TANPOPOPIAS i
"mollamia uéca' péocw TV omoiwv n minpopopio amolnkeveral, UETAOIOETOL,
TOPOVGLALETAL 1] VIVETAL OVTIANTTH ZOUPOVO PE AVTOV TOV OPIGUO, VO GUGTIHA TOV
oVVOVALEL, YIo. TOPAOEIYUa, TOV EAEYY0 PIVTIEOKOAGETAS KAl ONTIKAYV HEGCWY
amoOnKevons umopel vo yopoktTypiotel g ovotua molvuécwyv. Emiong cvetijuaro
rolvuécwy Oa ival § epnuepioa, mov GVVOVALEL KEIUEVO Kal EIKOVA, KOl 1] TIAEOpacH],
OV GVVOVASEL HY0 Kal KIVOUUEVY EIKOVA.

Epeig opwmg dev Ba avagepopaote oe 1660 upv acpa cvotnudatov. [eplopilldpacte o
aVTa 6T 0Toin 1| TANPoPopia gival yneakn (| ynetomomuévn - digitized) kot eréyyeton
amd vroAoyloty|. Evolapepdpocte onladn yio ynolokd mtoAvpuéoa o omoia kot opiovpe
g &&Ng:

»PNprokxd molvuéca Eval 0 TOUEAS TTOV AGYOAEITOL UE THY EAEYXOUEVY ATTO DTTOLOYIOTH
0LOKINPOGH KEWUEVOD, YPOAPIKAY, AKIVYTIS Kol KIVOUUEVS Elkdvag, animation, fyov,
KOl OTOL0VONTOTE G0V HEGCOV WHPLOKHS OVATAPAGTACHS, ATOONKEVONS, HETAOOGHS
Kol enelepyacios THS TANPoPopiag.

Eneidn om ouvvéxein Ba  aocyoAnbovpe povo pe Tt ynolokd moivpéca, Oa
YPNOYLOTOIOVUE TOV OPO TOAVUEGO EVVOMVTOG TO YNELoKa moAvpéoa. Emiong wg péco
Ba evvoole Tovg THTOVE TANPOPOPIAS TOV AVUPEPEL O TOPATAVE® OpLopoOc.Atapdlovtag
OVTOV TOV OPLGHO, ONUOVPYEITAL TO EPMTNUA: TOLOVG Kol TOGOVG THTOVG AT POPOPIOG
TPEMEL VO, GLVOLALEL Eva GVOTNUA, Yo Vo, Uopel dikata vo yopaktnpileTol ®g cVGTNHA
noAvpécwv; Onwg eivar govepd, 1 omdvnon 6€ oVTO TO EPAOTNUA OEV UTOPEL Vo givor
aVoTNPY, YTl deV EYEL YIVEL KATOLO GLUPOVIO TAV® GTOV OPLoUO TOV TOAVUES®V. Oumg
otV wpaén Exovv dnpovpyndel kamowor de factokavoveg mov kabopilovv T1 mpémel vo
TEPLAAUPAVEL EVOL GUOTN O TOAVUECOV OVAAOYOL LE TO EI00C TNG EPAPUOYNG.

Ymv wpan, 0 6pog TOAVUEGO VTTOVOEL TNV OAOKANP®OT| €VOG TOLALYLOTOV "dlaKplTon”
TOMOV TANPOPOPiag Kot £vOG "cuveyots”.Otav évag THTOg TANPOPOPIag £XEL LOVO YOPIKN

10



dtbotaor ovopdleTor SloKPTtOg. AV VIAPYEL KOl 1] CLVIGTOGOH TOL YPOVOL OVORALeTL
ovveyxés. [a mapadetypa, ol ekdveg, T0 KEILEVO KOl TO YPOOIKE €ivorl dlaKplTd, EVO TO
Bivteo, 0 fyog kai to animationeivat cuveyn.

‘Evag dAlog draympiopog sivar o capturedcon synthesizegiéca.

AVTOG 0 SLYWPICUOG OVOPEPETOL GTOV TPOTO UETOPOPAS TNG TANPOPOPING OTI LOPPN
oV VIayopevEl o kdBe TOmOg. Av 1 mAnpoopic cuAiapfaveton amegvbeiag amd TOV
TpayHoTIKd KOopo kdpe yoo captured mediave av dnpovpyeitor amd tov avOpmmo
Héow kamowwv gpyaleiov £xovpe ta synthesized svvOetcd péco. o mapdderypa, po
YNOLOKY QOTOYPAPIKT UNYovn M évag SCaANNErpetaeEépel oLTOUATO TNV EKOVO €VOG
OVTIKEWEVOL OE YNOLOKT HOPPN KOTAAANAN Yo Xpnon oTov LIOAOYIoTH. Aniodn ot
ewoveg givan captured medidlo keipevo, 0tov avTO TANKTPOLOYEITUL GTOV VTOAOYIGTNH
elvar mpoavadg cuvheTiKO Héco. Av dpmg Aapupdvetor péow Scannerkot TpoypEapaTog
OCR npémer va Bewpnbei og capturedOla avtd To péoa mov £xovv avapepbel wg topo
amgvBouvovtal oyeddv amoKAEIoTIKG otV Opaotm Kol otnv akon tov avipomov. Eva
oVOTNO TOAVUEC®OV OEV TEPLEYXEL OMOPOAITNTO TANPOPOPIES YOl TAPOUTAVE® OO ioL
a1 og1g, TapOAo TOL KATL TETO10 eivan Yevikd emBounto.

2.6 Xnpepa, gpeic kot ta [MoAvuéca

Ta ITolvpéoa (Multimedia) yio gpdg givor 0 KAGS0C TG TANPOPOPIKNG TEYVOAOYING TOV
OOYOAEITOL [LE TOV GLUVOLOCUO YNELOKADV SEGOUEVOV TOAAUTADY HOPPDV, dNA. KEWWEVOD,
YPOQIKADV, €KOVOS, Kwvoduevng ewdvag (animation), fyov xot Pivieo, yw v
avaTopdoTact, Tapovciaon, oamodnkevor, petddoon Ko emeepyacion TANPOEOPLOV.
Avto0 oL €100VG Ol EQPUPUOYEG OVOPEPOVIOL (G TOAVUECIKEG EQAPUOYEG, TITAOL
TOAVUEC®OV 1| TOAVUECH KOl ATOTEAOVV GNUEPO HaL OO TIG TTLO SLVOLLKG EEEMOCOUEVES
TEYVOAOYIEG OTOV YMPO TNG TANPOPOPIKNG, ME TPOKTIKEG EQPUPUOYEG GE TOAAOVG
OLPOPETIKOVG TOUEIS dpaoTNPLOTNTAS, OTMG EKMAIOELOT), EMOYYEALONTIKY KOTAPTION,
ayopa-OlaPN LG, TAPOVCLAGELS, YLYXOY®YiR, NAEKTPOVIKG oy vidia, TEPImTEP TAPOYNG
nAnpoeopidv (Kiosks),mmiedidokeyn, Internetk.d.

2.7 To Yroroyrotika Xvotiuoto [loAvpécmv

Mmnopovpe va dtakpivovpe dV0 KOTNYOPleEG VITOAOYIOTIKOV GUOTNUATOV TOAVUEC®V  TOL
CLGTNUATO AVATTLENG KO TO. CLGTHUATO TOPOVLGINGNG TOALUES®Y. To cvoThuaTo
avamntuéng Bo mpémel va YOV LEYAAN VTOAOYICTIKY oYV, TOYXVTNTA Kol AIToONKELTIKN
KavoTTO, AGTE VO UTOPOVV VO, LITOSTNPILOVY LE ETLTLYIO TV TOAVTAOKY dtodikacio TG
eneEepyasiog TOv HEYAAOL OYKOV TOAALOTAMY LOPOOV OEOOUEVOV TOV OTOLTEITOL YLl TNV
avanTLEN U0G TOALUECIKNG €QAPUOYNG. ATO TNV GAAN pHeEPLd, M TOPOVLGINGT HLOG
EPAPLOYNG OEV EYEL YIOL TNV EMOYN HOG LEYAAES OTOUTOELS EEOTAGLOVD.
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2.8 To Xvotipata Avartoéng [llolvpécwmv
Ta cvetuaTo TOV YPNGUYLOTOIOVLE V1ol TNV OVATTLEY, dNA. dNLoVPYIN 1} GLYYPOET, HIOG
TOAVUEGIKNG EPOPHOYNG efvar Ta €ENG

* Yvokeovn Pivteo

* Kapra Bivreo (video grabber)

* Bwvteokapepa

* Mwkpdpwvo

* Pnowakd kooetoemvo (DAT, Digital Audio Tape)
* Ynerokn poToypaIKy pnyovi

* Yopwtg (scanner)

* Eyypagéag CD (CD Recorder)

* Oonyog DVD (Digital Video Disc)

* E€wtepucog okinpodg diokog

* Aoxérteg Zip kou Jaz

2.9 Ta Xvotatika Xroyeio Tov [Holvpécwmv

To keipevo, mov amotelel 10 PacKOTEPO GLGTATIKO G’ AALEG VTOAOYIGTIKEG EQPAPUOYES,
Exel évav OaQopeTikd poAo ota moivpéca. Eilval apketd meplopiopévo agol €xet
avtikataotafel omd to GAA0 GLOTATIKA oTOlXElD TV TOAVUES®V, OTMOG Elval O YOGS, TO
Bivteo, m dwdoyn ewodvov k.4. Elvar, Opmg, amapoitmto oe oplopéveg TOAVUECIKES
eQapLOYES, OTMG glvar ot eykvukAomaideleg. H ewodva amotehel 1o onuovtikdtepo KoppATL
OTOV KOGHO TMV LTOAOYIOTOV Kot €W01kOTEPO oTo. MOoALUESH. Ewkdveg pumopodpe va
ELGOYOVLE OE 10, TOAVDUEGIKT €Qaproyn pe ) Pondeta tov capwth (Scanner)omov n
6N dadikacio Aéyetar ynelomoinon g eikovog, N va Tig tapovue (katefdoovpe) and
to Internetn and CD 7 amd diokéteg .Metd 10 OPTOUO TNG EIKOVOS GTOV VTOAOYIOTH
Hag, etvot KoAO vo, YpNGLOTOGOVLE EVa EOIKO TPOYPAUILO ETEEEPYATING EIKOVAG, OTIMG
givar To Photoshop,ywr va Beltidcovpe v guedvion g ekdvag Kot vo v
TPOCAPUOGOLE TNV epaproyn pog Ta ypaeud eivor gikdveg mov dnpovpyode povot
HOC OTOV VLTOAOYLOTN ME KATAAANAQ mpoypdupata, omwg sivar to PhotoPaint,to
PaintBrush Zoypagwn), to CoreIDRAW, 1o lllustratork.a.

To animation gwovuevn €ikdévo 1| TPOCOUOI®ON Kivnong) &ival ypoeikd mov £xovv
dnuovpynBel oe vroroylot pe WK Tpoypdppota diodtdotatns (2D) N tpiedidotatng
(3D) povteromoinone. To mpoypdppoto avtd £xovv T SvvatdTTA Vo dNUOVPYOHV
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OVTIKEILEVO  XPNOHLOTOIOVTAG ooV Pactkd (Sopkd) ovoTatikd OmTAG YEOUETPIKA
oyuota.l'o Tapddetypo, av meptoTpéyouvpe Evav KOKAo yopm and T dapetpd tov Ha
dnuovpynBel o ceaipa, EVO 0V TOV TEPIGTPEYOVUE YOP® OTTd U0 EPATTOUEVT TOVL Bl
onuovpynBel  €évag Aovkovpdc. Ta mpoypdupoTo  HOVTEAOTOINGNG UTOPOVV Vo
yepiloviar ta avtikeipeva ovtd ocav po oviomnta. To emdpevo Prua eivor 1
pwtopeaAiotiky ameikovion (rendering)lo Bivieo giodyetol oTov LIOAOYIOTH HE LA
ovokevn mov Aéyetar ynelomomtg (digitizer), n onoio avaiappdavel vo dopdacel v
avoAoyKn ewova Pivieo ko pe ™ péBodo ¢ detypotoAnyiog vo amobavaticel og
YNOOKY HOPPN KOL VO GUUTIEGEL GE TPAYUATIKO ¥pdvo avtd mov ddface oamd v
Bvteotovia. Av, OU®C, YPNCYLOTOUCOVUE YNOLOKN cvokeun AMyng Bivieo, umopovpe
va gwohyovpe Vv ewova Pivieo katevbeiov otov vmoroyiot. Ta apysion Pivteo
UTOPOVUE HETA VO T EMEEEPYOOTOVUE HE EWBIKA TTpoypaupata, Omwg sivar to Movie
Maker, yi vo KpatooLUE TIG OKNVEG TTOL MG EVOLOPEPOVY, VO TPOGOEGOVHE EQE
petdfaong, Myovg k.6.Emedn ta apyeia Pivteo €govv tov peyoldtepo 0yKo om’ OAo to
Ao otoryelor HaG TOAVUEGIKNG EQAPUOYNG, UTOPOVUE VO KAVOVLUE GLUTIEST Yo VO
pkpovovpe 1o pPEyeBog touvg, aAAd Ba €xovpe amdiern mowdtToc.H goaywyn kot n
eneEepyasio TOL NYOL Amd TOV LITOAOYIOTN HOLALEL TOAD | vtV ToL Pivieo, aAld dev
VIAPYOLV Ta 1010 TPOPANHaT e TV TTotdTNTO KoLl TO péyehog Twv apyeiov. Mropovue
He €01KA TPOoypAppaTo enesepyaciog Nyov va pEdpovpe, vo Tpochicovpe Q€ Kot va
BeAtioTomomoovpe Toug NYove, 6nmg to Audacity.
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2.10 Ayn aAavev pe yneuokn kapepao,

H Myn ewodvog givat, pouowkd, 1 kopla epyacio mTov Tpoceépel évo. camcorderMe
"Myn" ocvpPaiver to e&ng mopadoLo. Eivor m evkoAdtepn epyacio amd TAELPAS
YEPIOHOV TNG CLOKELNG, oG KoL 0 KaBévog pmopel vo Tatnoel To TAKTpo "rec” kot va
apyicel va ypapel. Aldeg epyacieg pe évo camcordereivol teplocdtepo TOADTAOKEG,
fowg Opm¢ va amaitoHv Kot Aryodtepo tarévto. [ldvtwg,

onpovpyia toviddv mov Ba apécovy pmopel va yivel oxeTIKE EDKOAN TPOYUATIKOTNTA,
apkel v TNPNooLvUE KATOolovs Pactkovg KavOVeS KT TN Ay, EVO 1 KOTavOnon ToV
TPOTOV AEITOVPYING KAl TOV SLVOTOTHTMV OV TPOCPEPEL TO cCamcordentov £yovue ota
YEPLOL HOG UTOPEl TPOYHOTIKA VO OTOYEUDOEL TOLOTIKA TO OMOTEAEGHO. Boaokn
npodmoheon eivan va eEokeiwBovpe pe ™ cvokevr|. H tpocPaon pe ta

YEPLOTNPLO. TPETEL VO, YIVETOL GYEIOV OWTOUATMOS KOL VO, UMV CTATOAGUE XPOVO Y10 VOl
Bpovpe To KGO TANKTPO. TN GOTOYPOPiC OVTO UTOPEL VO GUVETAYETOL TOV OTAOAELN

™G "oTiyung”, n omoia vhpPYEL ) OV LILAPYEL, TEMKA, ATOTLTOUEN.

Y10 video 6umg mpochétel ypdvo otV EYypae] Kol iomg Kot avembdunta TAGvo, Kot
avtd mAéov pmopel va aAAdEel oto povtdl, yopic va givor BEParo 6t o pmopécovpe
EMTOHYOLLE

TOV 0PYIKO LG 6TOY0. Z€ avTd TO onueio va movue 6Tt Tpémel vo doBel Kot Tposoyr| KoTd
mv emAoyn tov camcorderO onuavtiKOTEPOS KavVOVOG TOL TPEMEL VoL £XOVUE TAVTO
VIOYT KoTd T ARYN givor va kottdpe otnv 006vn LCD 7 to opBoApockomio wg Oeatég
apd ©¢ yeprotéc. DEpvovpe Tov €aVTO pag TN oty g Aqwng otn 0Béomn tov Oeatn,
ot Béom exeivov mov peténerta Bo mapakorlovbncovy to TAdva mov tpafréape. Avtd
dev gival amhd ko etvon BEPato 0Tt Yo va emtevyBel yperaleton peyddn mpoonddeia, 1
omoia Bo pewwveton pe v Edoknon, eved Ba YIVOUOOTE TEPIGGOTEPO ATMOTELEGUOTIKOL.
Towg 10 TEPLOGATEPO EVOYANTIKO Baa Yo exelvov Tov mapakolovBel pio Touvia givol
T0 X€pt mov Tpépel. Ot andtopeg Kivnoelg Kovpalovv tov Beatn kot olyovpo emdpodv
apvVNTIKE ot dnpovpyio evivtdcemv. Agv givar Tuxaio 0Tt o1 6TafepomomTEg EKOVOGS
(Image Stabilizersyuvavtdvrol oyeddv e dha To camcordergd® Kot rTapo.

TOALG xpovie. O pOAOG AVTOV TV CLOTNUATOV &ivol, Kupimg, Vo TEPLOPIGOVV TIG
OPVNTIKEG EMTTOCELS OO TO "YEPL TOL TPEUEL" EOKE OTAL PLEYAAN TOALOTAGGLO TOV
zoom. H e&doknon pe tov kapd Ba odnynoetl oe Beopatikd amoteAécpoto kot givor 8
BéParo Ot Ba eiote oe Béom va KAveTe EVOQEPOVTO TAGVA OO YEYOVOTO TTOV LT
KOvovikéG ouvinkeg iowg kot va  unv  mopovciolov  evolpépov.  AOKIHAOTE,
TMEPAPOTIOTEITE KO, Kupiwe, Umeite 0T Aoyikn OTL Ta pATIo 6og ival | KAUEPO, TOV
EKTOC amd KOMOOVG TEPLOPICUOVS, TOV TPEMEL Vo Yvopilovpe, €xel Kot GAAES,
SPOPETIKEG IKOVOTNTEG VO BAETEL TOV KOGLO, HE SLAPOPETIKO TPOTO amtd O,TL TaL

pdrtio pLo.

2.11 To ynQuoKa Q& TNS YNOLOKNG KANEPOS KOl 1] Kivion TG

H npoomdbeia pog vo mpokaréoovpe mePIGOOTEPO EVOOPEPOV MG EPACITEXVES
gwovoteg pmopei vo BondnBel onpovtikd amd to yneokd EQE ToL EVEOUATOVOLV TO
oOyypovo. camcorderMmopovpe vo ¥PNGUYLOTOIGOVHE ONULOVPYIKG ToL EPE TOL KOTA
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KavOvo TPOCOEPOVTAL YL VO, OMGOVLHE Hio EVOWPEPOVGO. TPOTN OTN ANYN HOG,
tovifovtog pio cuyKeKpluévn KatehBovvon,

duiBeomn mov BEAovLE Vo KuplapyoeL 1] va yivel Teplocdtepo avTiAnmn. [ Ttapdderypa,
av Béhovpe va Kdvoope v Tovior pog vo potdlel ToAod UTOPOVIE VO TNV YupicovLE
ACTPOLLOLPT, | LTOPOVLE VO YPNCILOTOGOVLE TO €QE "Sepia’yio va

ddoovpe pia (eot kot oweio aichnon otig Tovieg pog. Amd moArd povtédo camcorder
vrootnpiletonr N TpooHNKN eOvVTOL, pio Sadikacio Tov givor cuvnONG OTIG TNAEOTTIKES
EKTOUTES, EVOD, KON omAoVoTEPQ, 1| TPOooHNKN mAoiGiov Ypapikmv Edwkd n tedevtaia
dwdtkacio etvor O1UTEPOS TPOTIUNTEN KATA TIG ANYELS TOOIKAOV E0PTMV KOl TAPTL,
a@o¥ tovilel Tic evBvpeg otrypég kot divel pia awodntiky JIoAv evdapépovoa givar 1
JuVATOTNTA TOV TPOGPEPOLY HEPLKE camcordetylo Ayn Jado K@V GTIYIOTUTIOV, e
OLTOUATO TPOTO. X& AVTH TNV TEPImT®ON elpaote oe BEon va pubuilovpe ta ypovika
ST AT EVOLAUESH OO TIS EYYPAPES, OVAAOYOL [LE

T0 B€pa oV KvnpaToypapeiTal.

H Aeuwrovpylo eivor dwaitepa ypnoun Kotd TNV KOTOYPOPY] QUGIKMOV QUIVOUEVOV
EvoAloktikd, pmopeite vo TEPOUOTIOTEITE HE TIG TAXVTNTEG TOL QOTOEPAKTN, uio
duvatodtnTa. TOL TAPEXOLVY TOAAG camcorderotny yelpokivnn Asttovpyio. E@dcov, to
EMTPENMOVY Ol GLVONKEC QPMOTIOUOV, UTOPOVUE VO YPNCLUOTOU|COVUE Mo 7o apyn
toyvTTe TpaPaviag AMyotepa Kopé avd OELTEPOAENTO. ZTNV TEPIMTOON TOL TO
OVTIKEILEVO TTOL KIVIUOTOYPOPOVUE KIVEITOL GYETIKA YPIYOPO UTOPOVUE VO EMITUYOVLE
OPKETA EVOLOPEPOVTO EQE, 1| OTAMG VO ToVicovpe TV Kivnon. H cuvtpurtikny mistoyneio
tov camcordersiafétel kamolo choTnU Yo ANYels ™ viyto. Avtd yivetar Kupiog pe
Tpelg Tpomovg. Eite pe 9 exmoumn kot Aym vrepvbpwv, gite pe avénon g evaicinoiog
TOVL GONTPO KOl TOAD apyNG TOYVTNTOG QOTOPPAKTN, €€ HEe cLVOLACUO T®V VO
peBdOV. XNV TPMTN Kol TNV TPit TEPITTOON N EIKOVA £YEL TPAGIV YPOUOTIKY VO,
eVd o1 0evTEPN M edvo datnpel o aBevTiKA ypdpaTo. XOPUKTNPLOTIKO GE QLT
mv

TEPIMTOOT- Ol VIOYPEMTIKA UEOVEKTN IO~ Elvar OTL OV amoTLTOVETAL KoBapd 1 Kivnon.
H ocvunepipopd avt pmopei va eavel xpnoun av Blovpe vo tovicovpe v

kivnon, oAAG ko va mpoPAnpatiost oty mEPITTOON TOL BEAOLUE VO KOTOYPAWOLE
kaBopn KoV,

Ye 0,1 agopd, TEAOG, TIG emUEPOVG Wlaitepeg ovvOnkeg ANymg, OT®MG otV
KIVNHLATOYpapnot adAnudtmv, o yloviopévo neptBdAiov 1 evog nAlofactiépotog, tao
camcorder mpocEEPovY  EBIKG  TPOYPOUUOTO 7OV  KOTA  KOvOVe  AELITOLPYOHV
amoTEAEGHATIKA. [TdvTa Op®G va ETXELPEITE VO TEPOAUATICTEITE LIE TIG XEWPOKIVITES
(manual) pvpiceic. H otatikn amnewdvion piog oknvig (ototikny pe v €vvola OtL M

oyéon Kapepog TePPAALOVTOC YDPOV KOl AVTIKEIUEVOL TAPAUEVEL 6TOOEPT) oTAvVIa divel
mv aicOnon g Tinpdtntag. Ao TV AAAN, 1| GLVEXNG Kivnon, 1 aAAayn TG

TPOOTTIKNG 1) AKOUN Kot 1 -X0pig oxES0 Kot AoYKn- aAlayn| Tov KevIpukol BEpartog piog
OoKNVNG UTOpEL EDKOAN VOl YIVEL KOVPOOTIKN 1], ATANDGC, VO UNV EMTPEYEL TNV

peTapopd g 10éag N Tov yeyovotwv. Mia kadn Wéa givar va £xete TAVTOTE GTO HVOAD
0ag TIG PacIKEG KIVIOELS TNG KAUEPOS Kot VoL TpooTafeite vo avaydyete TV

Mwn oag og pio (apykoc) 1 o€ £V GLVIVOCUO TV KIVIGEDV AVTMV.
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O1 Baowkéc kivnoelg sivar técoepetc. To Pan go Tilt , o Roll kot to Track ) Dollie).Xto
panningn kauepa akoAovdel éva avtikeipevo kabdc avtd Kiveitor TapdAAnAa pe tov
opilovta g oknvig, evd oto tilting n kapepa akorovbei Eva

avtikeipevo kabmg autd kveitor kabeta otov opifovta g oknvie. To panningkot to
tilting eivar o1 Tep1oG6TEPO GLUVNOIGUEVEG KIVIIGELG LITOPOVV VAL YIVOLV LE TNV

KAMLOIKT KEPAAT KAOE TPITOSOV Kot -EVVOEITAL- TO KIVOUUEVO OVTIKEILEVO UTOPEl v punv
VIApYEL AALG va vtovoegitat. [ mapadetypa, "oviikeipevo™ umopel va givat to

BAEUHO TOV EIKOVOATITY KOODS GOPADVEL TOV YDPO YAYVOVTOG Y10 KATL.

2.12 Baoikd povtal Kou 1 TPoETOLRAGia TOV YDPOV EPYUCiaG

Ewcayoyn apovtdpiotov mldvov 6tov nAEKTpovikd vmoAoylot|.Me v ekkivnon tov
Edius 50nrteitar ocvvnbog 1o mepipdArov oto omoio B€lovue va dovAéyovue. Amd ta
CLGTHLOTO LETAGOONG OV VIAPYOLV KAAd gival va emAéEovpe T0 cHOTNHO LETAOOONG
oV VIApYEL ot y®pa pog to PAL. Ao ekel ko mépa eivon kobopd Bépa emAoyng Kot
npotipmong kobapd own pog. Emedn to Edius 5 Bvudtar v oapywkn 0éom ke
apyetov Tov

YPNOYOTOIOVUE G Eva £€pYo, KAaAO givar vo Bopdpaocte v 0on Tov Kdbe apyeio mov
YPNOYLOTOIOVUE 1 Vo ToToBeTOVpE TOL apyeia ovTh oe EEXYMPLOTO QAKEAO YlaTi av TaL
LETOKIVOOVUE 1 TO dtaypdyovpe To Edius 500 pog {ntdel va Bpovpe v 0€om tov kabe
apyYElOv OV YPNOUOTOLOVE GTO £PYO TO OTOI0 SOVAEVOVLE .

Ot tpémot kartackevng evog video sivor mapd moAloi. Mmopei vo mepéysl amAdg
EVOAAOYN EIKOVOV LE KOTOWL OQNynNomn M OKOUO KOl HOVGIKY . XTNV CGUYKEKPUUEVT
gpyacia, Adyw xoboapd Owkng pov mpotipnong Oo meplhdfw : evaAlayr TAAVOV,
KIWVOOUEVEG Kol akivnTeS EIKOVES, ap1ynon, Hovoikn Kot e cvvévtevén .To 6lo Project
Bo Tpaypatomon el amokAEIGTIKG OO EUEVO GTO TPOCHOTIKO OV VTOAOYIOTH UE TEAMKO
Bivteo PAL (4:3) kot moA AOYy® mpoTipnons -A@eobd £xovv yivel Ta yupiopoto Kot 1
OGLYKEVIPOON TOL VAKOD HOG TPOYWPAUE GTNV E10AYWOYTN TOVS GTOV LIOAOYISTH. AOY®
TOV HEYOAOL OYKOL TNG TANpoopiac mov meptEyel o Pivieo — eikova, yperolopoote
Evav apkeTd ypryopo tpdmo kat owtdg eivor o IEEE1394 aAliig fire wire .

Yvvdéovue to camcordefie Tov VTOAOYIGTH Kat 6TV cuveyeia avoiyovue to Edius 5,y
VO EIGAYOVE TO DMKO ETAEYOVLLE

File > Capture

Me tov tpdémo avtd €xovpe Eleyyo tov camcordermapdiinia Bétovpue Kot TG GAAES
TAPOUETPOVS OTTOC TOL Bol amobnkedovpe Ko 6€ TL HopEY|, Tt cvurmieon kot BePaio amd
7ol onueio péypt mowo onueio otn tawvio Tov camcorder O okAnpdg Sickog TOL
ypEGleTOL TPEMEL VO €IVl OPKETA PEYAAOG L0l KOL TO TTPOYPOUUO KAVEL KOTAYPOQOT|
(Capture )oe popon avi. Evéewktikd umopodue va movpe 0Tl ¥pelaletor yio o opo
towvio ypetdleton mepimov 18 GB pvun Etol kataiafaivovpe ot ypetdlovrarl peydrot
oKAnpoti dickot, Wwitépa OTOV 01 EPAPUOYESG LG TEPLEXOLY peyaia Bépata.l o KaAdtepn
guypnotia tov vrodnkevpévoy apyeiov avi to torobetodpe oty 18i0 OuaAdo PAKELOL
EMAEYOVTAG KOAG Kol €0GTOYO OVOUOTO, MOOTE €VOL EUKOAOG O UETEMELTA EVIOMIGUOGC
TOVG.
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H devbéton tov napabipov, Tov TAAETOV Kol T®V GAA®V otoyeimv 6to Tapdbuvpo
gpappoync tov Edius Samokaieiton ympog epyaciog (Workspace).

Yndpyovv tpeig dapopetikoi yopor epyaciog v emefepyasia :Editing, Effect ko
Audio.
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KE®AAAIO 3

3.1 State of the art

H enelepyacio ynoeaxod Pivieo mpovimobéter avtiotoryo Aoyiopukd. Ta Sabécipa
AOYIGHIKG 0VTNG TNG

KOTIYOpilog KAAVTTOUV £va, LEYOAO 0POG AVOYKAV TOV EKTEIVOVTOL OO TNV EPOCLTEXVIKT
EVOoYOANON HEYXPL

TIG emayyeAUATIKEG TTopaymyEg peydlwv otovvtio tov Hollywood. Emmpdcberta, ta
AOYIOHIKG 0VTA UTOPOVV

va dtokplBovv og mpog v ddeta mov datifevran o WOkt Ko EA/AAK. Aoylopikd
6nwg to iIMovie 1 10 Movie Maker givar dwadedopéva 0ALG TOAD TEPLOPIGUEVOL GE
duvatotnteg. And v AN TAevpd, Aoyiopkd onmg too Final Cut Studio, Sony Vegas
Pro, Shake, Edius 5 «tA mpoc@épovv moAd peydreg duvatdtteg 0ALL ExovV TOAD
VYNAO KOOTOC OmOKTNONG avad adeto ypriong. And v dmoyn avth, n ypon EA/AAK
Yo

mv eneepyacio ynookod Pivieo ommv ekmaidevon poldlel Wwitepa EAKLOTIKN
TPOTIOTOG Yoo AOYOVS OlKovopiag KoOdG T0 omoutoVUEVO KOGTOG AmOKTNGNG OOEIDV
xonong eivor pndevikd. Qotodco, ot Pacikoi Adyor emhoyng EA/AAK vy v
eneEepyasio ynelakov Pivreo onuepa dev oyetiloviot 1o PNdEVIKO KOGTOG

OALG LE TO YOPOUKTNPIOTIKA, TNV TPOCUPHOCTIKOTNTO, TV amOO00N Kol TIC SLVOTOTNTEG
OV TPOGPEPOVTAL.

Allo gpeuvnTiKd evolopépovta elvat:

Opoadomoinom, TUNHATOTOINGY, TOAVPAGHOTIKY OVAALGT XPDOUOTOG Kol VONG, OVAALGT
Bivteo Kol avoyvodplon oKnvav, kmotkomoinon kot wepiAnym Pivieo. Avayvaopion kot
Avdivon TIpotonwv 6mmg péBodot e€aymyn Kot EMAOYNG XOPAKTNPIOTIKAOV, VEVPMOVIKA
diktua, davuopaTiky KPAavtion dedopévev, TeXVIKES TaSvOUNOoNG Kol OUAd0TOINoNG
OEQOUEVAOV KOt PLOUETPIKEG EQAPUOYEC.

3.2 Xpovooraypappa TTUYLOKNG

Teyviko pépog

ANy TTUYLOKNG 10-2-2009

YvykpoTnon cevapiov 15-5-206G%¢ 30-5-2009
YuyKpOHTNON LVAKOV 1-6-2008n¢ 20-6-2009
-GLALOYY] TANPOPOPLDY

Ay TAGvVOV-ZovevtenEelg 1-7-2009 e®¢ 20-10-2009
Movrtépiopa taviog 1-6-201@mg 15-6-2010
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OepnTIKO péPog

Ewayoyn

Avdivon pebodoroyiog
Xyédo dpaomng
Amoteléopata

10-101Dew¢ 25-10-2010

28-10-20Xdhg 20-11-2010
22-11-2040; 30-11-2010
5-12-20k0¢ 28-12-2010
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KE®AAAIO 4

4.1 O péiog TOV povTal TNV KIVI|LOTOYPOQPLKI] OLEPYACLO

«To vonuo pioag xair Hovo votag o’ Evav HOVGIKO GKOTO, TO VONUO, 110G KOL LUOVO AEENS
Uéoo ge pLo. TPOTAoH, OTOKAADTTOVTIAL UOVO UEGO. OTTO TO GOVOAO TOVGS, THV OAOTHTO, TOD
HovaIK0D 0KOTOV 1 THS TTPOoTaonS. To idio 1aydel yia ty Oéan ko T0 poio evOg TAAVOD uéaa.
010 0A0 o puag Kkivnuotoypapikns toaviog.» (Mrélo Mraiol, H Oswpio tov Diiu).

4.2 T gival to povtal

To povtal amotehel anldc T cvvdeon piog Aovpidag @iy (TAdvo) pe pio dAin. Ta
TAGVO. GUVEVMOVOVTOL GE GKNVEG KOl Ol OKNVEG GE HOKPUTEPNS SIUPKELNS GEKAVG. XTO TTLO
UNYOVIKO ETMEDO, TO HOVTAL apotpel TOV TEPITTO YPOVO KOl YMPO. AUUEGOV TG EVMOOTG
TOV 10e®V, T0 LOVTAL GLVOEEL TO £va TAGVO HE TO GAAO, TN [t GKNVY| HE TNV GAAN, Kot
ot KaBefng. AmAmdg, 660 avtd pmopel tOpo va. eovel, M covpPacn TOoL HOVTAL
OVTITPOCMTELEL O0,TL 0 KPtikO¢ Terry Ramsayeovoaeéper ¢ 10 “ocuvtoxtikd” Tov
KIVNULOTOYPAPOL, TN YPOUUATIKY TG YAOCOAS Tov. Ommwg 10 YA®MOGIKO GUVTAKTIKO, TO
GLVTOKTIKO TOV HOVTAL TpEmet va d1dayBel — dev TO Katéyovpe ERQUTOL,

Ao TG TPp®TOYOVEG OmOPYES TV TPOW®V y¥pdveov tov 2000 audva, To HoVTal
eeliybnke oe pion éyvn peyaing moALTAOKOTNTOC, TOPEYOVTAG 0XeOOV KbE dekaeTia
véeg mapoaArayég Kot dvvordtres. [lpy v aAlayn Tov audva, ol TEPIGGOTEPES TOVIES
OTOTEAOVVTIOV OO GUVTOUO YEYOVOTO (PMOTOYPAPNUEVE GE YEVIKO TAGVO e pio Kot
povadtkn Aqym. Otav 1 urouniva pe 1o @ANL oxeddv e&avtieito, To cuuPav ypryopa Ha
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nepaiovotay. H didpkelo Tov mAdvov kot Tov yeyovotog ftav idteg. Xtnv ovsia ovTég ot
TPOIUES TOVIEG NTOV KATL TEPIGCOTEPO QO GUVTOMO BEATPIKA £PYQ TTOV KATAYPAPOVTOV
010 GEMAOWVT: M Kdapepa NTav axivnen. Ov nbomolol mapéuevav oe yevikd midavo. H
oKNVN £€TpEYE OLOPKAGC, LLE TOV PIALKO KO TOV TPUYHOTIKO XpOVO va glval Tepimov id10t.

Metéd 1o 1900, ot Todhia, otmv AyyAMo ot otV AUEPIKY, YOVTPOKOMMEVEG
e€loTopNoElS Ekavay TNV TPMTN TOVG guedvion. Oviog mo Oyt povo yeyovoto oA
otopieg, pe apyn, Héomn kol T€A0G, OVTEG Ol TOVIEG OOLTOVGOV TTEPIGGOTEPO OTd £Vl
amAd oknvikd kot pion owpkn Afym. Ot KnuaToypaeloTés OuThig TNg mTEPLOS0V
aVNGLYOVGAV OTL TO KOWO O O avTIAapPavOTaV TN GUVEXELD AVALEGH GTO £VO TUNLO
(m\évo) g 1oTopiag kKot 6to dAro. T va emAdcovy T0 TPOPANLUE TOVS, GTPAPNKAY YL
Bonbea oto Béatpo. Eddd, N aviaio tav pio amodekt| cOuPfact, mov vrodniwve pio
petdfaocn oto ypdvo 1N ko 610 Y®dpo. H aviaio, Kot ovciav, cuvédee TIG SOPOPETIKEG
oknvéc kot mpaelg o éva ovvektikd ovvoro. To fade otic tovieg frav 6,11 NTav N
aviaio 6to Béatpo. Me evieddg amdd Aoylo, avtd mov éva fade-outcvvenayotav, nrav n
EMITTOON TOL QMTOG OTO TEAOG g okNvng pExpt mov 1 oB6vn ywotav poavpn. H
emdpevn oknvi| otn ovvéyela Ba Eekwvovoe pe éva fade-in,mv avtictpoen dodikacia,
OV GLYVA OmOKAALTTE P SLPOPETIKY TomoBeia Kot Eva S1aPOPETIKO YpOVo. ZuvinBmg
01 dVO GKNVEG evdvovTay amd TV Tapovasio Tov id1o0v nhomolov. Amo to 1899 akdun, o
I'dlog George Méliesyopioe pio pikpod pnkovg tovia, ™ Cinderella, og gikoot
“drevBetnpéveg oxnves”.

YOvropa, ot oknvoBEteg dpyroav va KOPovv kot péca o€ Kabe oknvn. O Apeptkovog
Edwin S. Porter cuyvd motd®vVETOL HE GLTR TNV KOWVOTOUiO, MOAOVOTL OTNV
TPOYUATIKOTNTA Ol IGTOPIKOL TOV QIAUL £YOVV OVOKOADWEL TOALAPIOUO TPOYEVESTEPQL
mponyovueva 6to Bpetavikd owepd. Eviovtowg, avtd o peydro Pabuo ayvondnkov,
uéxpt mTov o Porterympic va éxet yvoon avtod Tov povtdal, to ypnoiponoince cto The
Life of An American Fireman (1903)Mia a@eing totopio g O146MONG KATONG
yYovoikag Kot Tov Tondlov e and évav mupocPécstn, N Toavio Tov Portermepiéyet entd
oknvés. H tedevtaio oxmvn meptlopPdvel opketd mAdva: 0 TuPooPESTIKO dynuo Tov
QTAVEL GTO PAEYOUEVO KTIP1O, £V EGOTEPIKO TAAVO TNG YUVAIKOG KO TOV OO0V THG TOL
EYOUV TTayOEVTEL OTO KOOUEVO KTipto kol €vo e£mTeptkd TAAVO TOL TLPOGPESTN TTOV
kateBalel ) yovaiko amd pio okdia. Avt n televtaio Tpdén emavoropuPavotay ot
d1c®ON TOV TOd10V.

[Mopadociakd, avti n oknvy Ba gixe Kivnuatoypaendet pe pio cvveyn Aym. Me 1o
OTAGIUO TNG OKNVIG OL®G G€ O10POopeTIKG TAGvVa, 0 Portereykafidpvoe to mAdvo Kot oyt
™ oKNvN, ©¢ TN POCIKN HovAda TG KOTAGKELNG TOV OIAL. AVTA 1| GOAANYN TOL HOVTAC
gykowvioce emiong v Wéa ¢ petafariiduevng dmoyng oty tawvia. Méypt eketvn ™
OTLYT], Ol TEPLGCOTEPEG TAVIEG KIVILATOYPAPOVVTOV UE OKIVITO YEVIKO TAGVO —TEPITOL
amd 1t Béon evog Beatn Tov BedTpov mov KeBITAV KOVTE oTn oknvi. H didpkela piog
OKNVNG OVTIGTOLYOVOE GTO TPAYLOTIKO YEYOVOS. AALA LE TO GTAGUO TOV TAAV®V TOGO
oe eEMTEPIKEG OGO KOl E0MTEPIKEG ToToBesieg, 0 Beatng eivat, Kot ovoia, kot ota 6Ho
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pépn tavtoxpoveoc. EmmAéov, emedn n towvia dgv eoptdror amd Tn OdpKeEl £VOC
yeyovotog, o Porter eionyaye évav meplocdTEPO LVIOKEWEVIKO YpOVO, £va XpOVO OV
kabopilotov and ™ didpkela TV TAGVOV (Kol TOL VIOIVIGGOUEVOL YPOVOL OV EEL
dtavubel avapesd tovg), Oyt amd 10 mTPoypaTikd cvuPav. Atopécov tov povtal, To
yeyovota, pmopodv va  doyk®wbBovv 1M va  cvpmvukvobovv, eaptodpeva and TO
JPOUATOVPYIKO GKOTO TOV KIVILLOTOYPOPLOTH.

4.3 Ewoaymyn oty Ocmpia Tov povral

H eicayoyn avt avagépetor 6Tnv cuvheon TG OTTIKNG Kol akovoTikng Toviac.H Tovia
OTNV TEAIKN LOPPT TNG ATOTEAEITOL OO €KOVOL KoL 10 €MEWDN| £G ONUEPA ameVBIVETAL
oV Opaon Kot akon tov avlpomov.Otav ovaeepOUOCTE GTNV TOVIO,EVVOOLUE L0
oAoKANpopévn] towvia mov Ba v eggtdoovpe aveEdpmmra amd TOo oucnTiKd NG
OmOTEAEG LT TTOPOOEGOVIE TOVG KOVOVEG TNG YPOLLUATIKNG KOl TOV GUVTOKTIKOD TNG OF
OTL APOPO TO HOVTAL KO TOV TPOTO EPAPLLOYNG TOVC.

OroxkAnpopévn Touvia AEYETOL OVTN OV €IVOL GUUTANPOUEVT] TEXVIKG KOl S yNHOTUKA
,MOTE VO LTopel vo, KOAOWYEL i, Tpoorn.

Texvikd oAokAnpopévn tavior AEyeTon vt TOv TEPUGE O0O0YIKE omd OAa To GTAIOL
eneEepyaciog KOVOG Kot X0V, OGTE Vo UTopel va TpoPAnOei.

Amynpoticd ohokAnpopévn tovia gival vt mov HEGH Ao TV E€1KOVO KOl TOV MO
OAOKANP®OVEL £vaL VOO TOITMOOTE 0 Og0Tig va TapakoAovBel o eviaio pio adldoTooTn
opaon.

Ta kOplo 6TAdIA TNG TEXVIKNG EMeLepyaciog EIKOVOS Kol YOV LG TOVIOG oVOPEPOVTOL
TOPOKATO,XOPIS v divovtor Wwoitepeg EMEENYNOELS,YIOTL OMOTELOVV OVTIKEILEVO TG
TEYVIKNG TOV KIVNULOTOYPAPOU.

4.4 Kwnpoatoypo@iki tovia
-AfNyn edvog

-ANym fxov

-Epodvion apvnticod eiip

-Extdnwon tov apvntikod euip og Betikd
-Metaypar) NY®V 6& HoyvnTikod Guip
-Teyvikd povtal

-ZUYYXPOVIGLOD
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-Eyypaon| o poyvntikd ouip mpdchetwv euotk®dv 1 texvnTedv opoifmv.
-Teyvikd povtdl tov BopHPwv pe Baon v eikdva

-Eyypaeni povouiig

-Teyvikd povtal g LOVGIKNG

Anpovpyikd povtal eikdvog Kot nyov

-M&Gg

-Metaypapn g PEQPIoUEVIS OKOVGTIKNG TOVIOG GE OTTIKO QAU

-Kom xot povtal apvntikov pe Pdomn to teEAMKO amoTtéAeGU OV TPOEKLYE amd TO
ONUOLPYIKO povTal

-Etodoval onladn n 010pOmon tuxdv YpOUATIKOV 1 QOTICTIKOV AAB®V TOL apvnTikon
yuoL TNV TEMKN EKTOTOOM).

-Extonoon A kémiag onAadn 1 EKTOTMOOTN TOV TEAMKOV HOVIOPIOUEVOD OPVNTIKOD OIAL
KOl TOV OTTIKOV QAN o€ OeTIKO UANL oV pmopel var TpoPAnOel amd Kvnpatoypopikn
unyovi TpoPoing

-Aopbocelg A komwog (ue Paon v A koma ©g delypo dNAad To avIitvmo NG
TOVIOG, YIVOVTOUL O TEMKEG YPOUOTIKEG KOl QOTIGTIKEG O10pOMCELG).

-Extdnwon teMxng kOTog Ko aviiypapmv

H oloxinpopévn teyvikd tovia dtakpivetar e 0o Pacikég Katnyopieg amd Ty amoyn
g oknvobeaciog:

Toawioa emkaipov

Touvia cvveyeiog

Orav Aépe Kot yopieg EVVOOULE OVGLOGTIKA TNV TEXVOTPOTI TNG TOVIOGS.
Ta xopokTnploTiKd oTIg Tovieg emkaipwv eivat:

-Agv Vapyel Tpooknvobesia ETOUEVMG OV €QOPUOLOVTOL Ol KOVOVEG TNG OTTIKNG KOl
OKOVOTIKNG TEYVNG.

-Ta vonuata ko cuveyeio otnv dpdon petapépoviot Kupimg pe to Adyo.

Ymv  Kotnyopic. oUTOV TOV  TOWUWOV  OVAKOLV: ONOP, GUYKEVIPMOELS, OLAPOPES
eKONAMOELS, peMOPTAL KAT.

Avrtifeta 0TI TOvieg ouvEyelag 1 tavieg pe vrdBeon OTMOG AAADG AEYOVTaL:
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-Ynhpyer mpooknvobeoia, emopuévmg eapuolovtor OAot Ot KOVOVEG TNG OMTIKNG Kot
OKOVGTIKNG TEXVIKTG.

-Ta vonpato petapEépovtal Kupimg e TNV EKOVO.

2ty komnyopio avty aviKoLV ot tauvieg pe vwodeon aveaptnto amd TOo UKOG 1 TV
dubpkell TOvG. AVAKOLV EMIONG OPIOUEVE. VTOKLHOVTIEP, OAAL KOl EWOWKEG ToUvieg
EMIKALPOV .ZTIG TELELTAIEG AVIIKOVUV GUYKEKPIUEVES EKONADGELS, OTIG 0moieg yvapilovue
€K TOV TPOTEPM®V, UE AEMTOUEPELES ,TL AKPIPMOG TPOKELTAL VO CUUPLDOVETOL EYOVUE TNV
duvatdmra ,ePapuolovtag Tovg KOvOVES TNG OMTIKNAG KOl OKOLOTIKNG TEXVIKNG, VO
Kévovpe MYELG KATIAANAES ,Tov pe povtdl Oa pog dMGoVY T0 AmOTEAEGHO TOL BEAOVLIE.
Ed®d éyovpue v mepimtwon ¢ oknvobeciag ek TV LoTéPOV, otnv omoio Ha
avapephole o AALO KEQAAOLO.

4.5 Nvroxkipovtép

YHETIKA UE TOV OPIoUO VIOKIUAVTEP LIAPYEL TOIKIAl amdyemv apyilovtag and Tig To
TOPOSOGLOKES TTOL VITOGTNPILOVY OTL TO VIOKIHAVTEP £fvorl va LAMKO Kelpevo Omov dgv
xpnoyLomolovvtal ototyeio pobomiaciog 6Tmg NBomool Kot GKNVIKE KabdG Kot 6evAp10.
Méypt T Mo ovyypoveg Bempntikéc mpooeyyicelg [mov apeiopntodv tov ido TOV
SwPopo HeTa&y Touviag pubomhaciog Kot Toviog VIOKILOVTED.

[Mopd T avtikpovdpeveg amdYelg YOP® amd TOV OPIGUO TOV VIOKLUAVTIEP OEV OMOTEAEL
TIOTN AVTILYPAQN LIOG TPOYUOTIKOTNTOG OAAA Lo epunveia TG TeAevTaing, CONEOVO e
TIG VTOKEWEVIKES EMAOYEG KOl TPOKOTOANYELS T®V Onovpymdv g towviog. Omwg
A wote kdbe PopEN POTOYPAPIKNG 1 EIKOVIKNG OVOTAPACTOCNG TO VIOKIUOVTEP AT
TeAEL IO KATOGKELT] VOV TOTO GUVAVTNGNG TOV SNUIOVPYOD LE TNV GUYKPLUEVT IGTOPIKN
KOl KOW®MVIKY TPAYUOTIKOTNTO TOPATAVE OMIGTOON Yol TO VIOKIHOVIEP ©C Lo
epunveion ™G TPOyUATIKOTNTAG Kol Oyl ®©C OVTOVAKANGY 1TNG MHOG EMITPEMEL VA
TPOGEYYICOVUE TO VTOKILOVTEP GTNV LOTOPIKT] TOV SAGTACT KPITIKA. AnAadt], Topd to
omoia. pNTOPIKd 1 AAAL TEXVAGUATO TOV YPNOLUOTOLEL O ONUOVLPYOS TNG TAVING Yol Vol
pog meicel 0Tt aTod MoV PAETOLUE EIVOL TPAYHOTIKOTNTA, OEV KOTAYPAPETAL TOPE LOVO
o amd TG EKPAVGELG TNG GLTH OV OMOPPEEL MO TNV ONTIKY TOL OMNUIOVPYOVVTO TLO
EVOLOPEPOVTA VIOKIHOVTEP OTNV 1GTOPI0 TOL KIVNUATOYPAPOL givor akpiBds avtd mov
TpoPailovtal ¢ avolytd Keipevo, touvieg OMAadn Tov EMTPEMOVY TNV dLVATOTNTO
AVAYVAOGTNG LG KOl LOVOOIKNG AdLACEITTNG OANOELG.

To vtoKloviép ®G KIWNUOTOYPOPIKY) TPOKTIKY OCULUTITTEL HE TNV  YEVEGT TOL
KIVIILATOYPAPOV ,CUYKEKPLUEVO LLE TIG TPADTEG TOVIES TOV AOEAPDV AGEC.

To €idoc avtd TOL KIVNUOTOYPAPOL TOPOLGiNGE WAiTEPN AvATTLEN TN OEKOETIOL TOV
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1920pe kvpiovg ekmpocdnovg Tov Pwcotliyka Beptoe kot tov Apepukavd Poumept
Ddroeptv. O Beptog, 0 enmnpeacpévog amd To Kivipo Tov KIVIOToypapov GOVTOVPLGLHOD
dnuovpynoe €va véo €100¢ VIOKIHOVTEP OV GTNPIYTNKE GTNV OVOTPOTY| TNG YPOUUIKNG
AQNYNUOTIKNG QOPLOG KOl GTNV TPOKTIKY avtoavagopikotntoag O 1010¢ ovopace oot
MV TPOTOTOPLOKY  Kivnuotoypaeikn avalnmon "Kino-Pravda"wnpatoypdpog
aAnfg1a) pio TApN EKEPacNS TG omoiog cuvavtodue otny tawvio tov KinoapparatomH
tovia tov Prept Nanook of the North(1922)ivot yia toAloOg | Tpd T OAOKANPp®UEVT
toawvio viokipoavtép. O Qragptv katoaypdest v Kanuepwn Lon o owoyeveiog
Eoxipoov otov Kavadsd. H tpocéyyion mov akilovOnoe ypnoiponoteitor akdpo Kot oTig
HEPES Hag Kupimg oV mapdywyn €0voypapik®v vtokvpoaviep Kot otmpiletor otnv
LLOKPOYPOVIO TOPATIPNOT KOL 6TV €KPAONON TG YA®GGAS Kot Tov Tpdmov {mng. Aot
ONUAVTIKOL EKTPOGMTOL TOL VIOKIAVTEP TNV 1Wia Tepiodo onv Avtikn) Evpomn ftav ot
Ntopwt Povtpov ot Feppavia po myv tawvio "BepoAivo”(1927).

1t dexoetion Tov 1930 dnpovpyndnke €va kivnua viokvpavtép otn Bpetavio mov oo
OKOTO €lye TNV KOW®VIKY a@Omviorn pe Ogpoatoroyio mov mnydlel amd v kabnuepivi
TPAYHOTIKOTNTO ZNUOVTIKEG Tovieg avtig TNE meplodovg givon to Drifters(1929)tov
Tlov I'kapodv ko Night mail tov Xoappv Ovott. Baocwkdc epyvymtig avtod tov
Kivnpatog etvar o I'kapcooviod 6molog Kat 16N yaye TOV OPO VIOKLUAVTIEP AVOPEPOUEVOS
oe avtd mov ovopale "onuovPYIKN dlayeiplon TG TPAYUATIKOTNTOS" .XTO TEAOG QLTS
NG OEKNETIOG TO VTOKLUOVTEP Ypnoipomombnke and v Feppavida Aevi Pneevotal yuo
Aoyovg mpomayavdag pe tovieg omwe to "Triumph des Wilestpya cov avtd ompi&ov to
yrepkd kobeotdg g voliotikng [eppoviag. Tic emdueveg dvo dekoetiec TO
VTOKILOVTEP iV ¢ KOPL0 BEP TOVG TOV TPAOGPATO TOAELO, TNV OVTIGTOOT] TOV AUDV
OTN YEPLOVIKN Kuplapyiol Kot ¢ KOl TIG EMATMOOELS TOV TOAEUOV, OTMG Y10 TOPAOELYLLOL Ol
tawvieg "Listen to Britain" kot "Nuit et Bruillard". Movo oto téhog g dekaetiog Tov
1950 Swokpivovpe adlayég ot Ogpotoroyio aAAd Kol GTOV TPOTO YPAPNS, OTWS Yol TO
napadetypo oto "On the Bowery"(1956)0v Apepikavod Agidve Poykolv. Ot adloyég
aLTEG  opeilovtay KupimG ONUOVTIIKEG TEXVOAOYIKES KOIVOTOUIEG OTOV YMPO TOV
KIVNUOTOYPAQOL OT®mg 1 dnuiovpyion eAapplag @opntng kapepag 16mm kot v
duVATOTNTA  GLYYPOVIGUOV TOL MYOL KIVOUHEVN EIKOVO GTOXELWL TOL  OlEVPLVOV
OVCLOOTIKA TO Tedl0 Oplong TV KWNUATOYPOPIOTOV. Méca amd TG KOvoUpyleg
e€elelg oty teXvoroYia Kivnpatoypdeov, dnpovpyndnke o "auecog Kivnuatoypdeog”
mov €iye ®¢ Kvplovg EKTPOS®OTOVSG TOL TOVG Apepikavovg Pikv Ankok ,Mainlv
Mmnpadepg kor Ahav [evvumainkep.

H xvplapyn ¢ucroyvouia ot dexoetic Tov 1960 6t0 y®dpo TOV VIOKIHOVIEP €ival O
I'6Aroc Zav Povg. Mali pe tov I'dAlo kowvovioddyo Evrykap Mopév ,0 Tlovg ovopaoce
™V TPocEyylon mov akAovdnoe’cinema verite"katd avtictoyyio tov (Kino pravda)tov
Beptog. Enpoviikodtepn oO1d@opa avVAUESH GTOV "KIVUOTOYPpApo-aAnfeln” Kot Tov
" QUECO-KIVNLATOYPAPOVVTOL OTL GTOV TEAEVTOIO O KIVIUOTOYPOPLOTHS TopakoAovOel Lo
Katdotaon Kpiong yopic va eneppaivel oto SpmdUEVa, EVEO N TOPOVGIN TOV gival OGO TO
duvatdv opatn .Avtifeta, "otov kwvnuatoypdeo-oAndeld” o KVNUOTOYPAPIGTNG
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TPOKOAEl TO OPAOUEVO, GUUUETEXEL GE GVTA KOl 1) TOPOVCIO TOV &ivol EUQAVIG Kol
KOTOALTIKY Yoo TNV €KPacn TOV TPOyHOT®OVOTOV TEPITTOoN OnAadn "Ttov apécov
KIVNULATOYPAPOL" 1 Kapepa Opo MG TopATNpNTNG, EVEO GTOV "Kivnuotoypdeo-oAindeia”
dpa MG KATOADTNG,.

>t dekaetion Tov 1970 évtovn eivar 1 TOPOVGIO TOL TOAITIKOV VTOKIUAVTEP KOOMG Ot
TPpOTEG amOTELPEG dNUovPYing epuviotik®v viokipavtép IleplBoplokég opddeg mov
NTav TAPUdOGIOKE OVTIKEILEVO TOV TAVIOV VIOKILAVTEP TOIPVOLV OTA XEPIL TOVS TNV
KAUEPO OTNV TPOCTAOELN TOVG VO YPNOLUOTOCOVY TNV KIVILOTOYPOUPIKT YPAPEIQ Vo
ekepdoovy éva moltkd Adyo. H mpaxtikn avt) Bo cvveylotel Kot 6T emOUEVEG OVO
deKaetieg, Wlaitepa PETA TNV SLAO0GT TOL O10€ OV EMITPEMEL TV TOPAYWDYT TOVIDV LE
YopnAdTEPO KOGTOG. ATO TOL TEAN TG dekaetiog Tov 1970{nmuato NOKAG OXETIKA LE
TNV OTTIKN aVOTOPAoTOCT] GAA®Y KOW®OVIOV KOODS Kol To EPOTNUATO CGYETIKA UE TNV
ékbBeon TOL 1010V TOL KIWVNUOTOYPOPLOT] GE OLTH TNV OlOOIKACIK, OPYLo0V Vo
OOCYOAOVV  OAOEVOL KOl  TEPLGGOTEPO  TOVG ONUIOLPYOVS TOVIDV  VIOKLUOVTEP.
Inuovtikdg Beopntikdg exmpoéconog g ovalnmong avtg o Apepwavog TCow
Poopmv, mov oamoacyoAnOnke 1dwitepo pe 10 BEUa TOL  AVOCTOYOGHOL 1 TNG
OLTOOVOPOPIKOTNTOG, EVE  TPOKTIKEG  EQPOPUOYEG OLTOV  TOV  TPORANUOTICUOV
ouvavtovpe 6Tl touvieg ™G Apepwavidog Mmapurapo Mrepyoe Number of our
days(1977)xor In her Own Time(1985)tn dekaetia Tov 1980 kar otic apyic TG
dexkoetiog Tov 1990 mopatnpeitor o TGon ETAVOTPOGOIOPIGUOD TNG TAPAOOGLOKNG
eOppag tov vrtoklpovtép. H ypoppukn aenynuoatiky dounl mov otnpileton oTOV
KOTOKEPUOTIGUO KOL TNV AOSOUNCT] TOV GIAUIKOD YMPOL Kot ¥pOHVOL, LK TPOKTIKY TOL
HOG EMOVOQEPEL 0TI KOAMTEXVIKEG avalntnoelg Tov Beptwe. 'Eva dAlo otoyeld mov
yapoxtnpilel Tig apyéc g dexoetiog Tov 90 eivon 6TL apkeTOl dNUOVPYOL VIOKIHOVTEP
EVOMUATOVOVV TIG TOVIEG TOVG EPUCITEYVIKO OTMTIKOOKOVGTIKO DAKO OV £XOLV Yupicel
01 10101 01 AVOPMTOL TOV KIVNLOTOYPAPOVVTOL.

4.6 O yopog epyociog editing ko Tov effects

O ydpog epyaciog mov Ha ypnolponomcovpe eEaptite

and to €idog g epyaciog pog Avty  pébodog tarpralet pe v ocvpPartikn pébodo A/B
Roll Editing ka1 ypnowomotei dvo Pivteo (a kot B) ko évav pnyovioud (@é) yo v
aAlayn TAdvov.To mapdbvpo Monitor gpeaviCetor povo mv mpoPoin Ipoypdupatog (
Program ) kot tovg unyovicpodg eréyyov. Ta video avoiyovv oe éva Eexopiotd
mopabvpo.

To mapdBvpo Timeline pe o dibypappo porg xpoévov gupavifetar to kavail Video loe
EKTETAPEVT] LOPOT], LE TO KAVOAL Yo To €€ aAAhayng mAdvov (Transition)peta&d tov
kavaldv Video 1A ko Video 1B.Eivot dabéotpeg 6Aeg ot maAéteg, aAld KAl EVEPYEC
uovo ot toréteg Effect Controls, Navigatatot Transitions..
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O yopog epyaciog Effects,o onoiog pag napéyel mpdcPaon ota e@é Nyov kot Bivieo kot
YPNOOTOLEL TOV TPEYOVTA YDPO EPYACIOG LG HE TIC OKOAOVOES OLVOTOTNTEG -

Video Transitions:

H moAéto avt pog emrpénel va mpochitovpe ep€ aAlayng TAAVOL HETOED TOV TAAVOV
OV VITAPYOVY GTO SUAYPOLLLLO PONG XPOVOU .

Audio Transitions:

H moAéta avt) pog emtpémel va eQappOGOvHE Eva NYNTIKO €QE GE OMOL00NTOTE N0
&yovpe elodyel oto mapabvpo Timeline.

Video Effect:

H modéta avt pog emtpénetl va epoppocovpie Eva epé videooe éva TAGvo tomobetnpuévo
oto kavil Video 17 og onoadnmote avotepo kavail (veépbeon) .

Audio Effects:

H maAéta avt pog emrpémetl va epapuoOGOVLE Eva NYNTIKO EPE GE OTOL0ONTOTE YO TOV
&yovpe elodyet oto mapdabvpo Timeline

4.7 O yopog epyasiog Audio ko To TapdBvpo project,timeline
KoL monitor

O yopog epyaciog Audio, o omoiog pog mapéyel TPOSPacn GTo EPYUAEIN TOV ATOLTOVVTOL
Yy v eneepyacio NYNTIKOV KAVOALDV, YPNCULOTOLEL TOV TPEYOVTO YDPO EPYACING OO
1e T akOAOVOES TPOGAPLOYES :

Ta videoavoiyouv g éva Eexmprotd mapddupo, ivat avorytd o mapddupo

Audio Mixer kot o1 ToAETEG deV ival OpoTES .

Oa ypnoyomomcovpe dapopd mapdbvpa yioo vo XEPIOTOVUE TO TAGVO HOG KOl VO
HOVTApovpE TO TEMKO pag Bivieo, kupiog Opmg Bo dovAéyoupe pe ta tpio
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Tapabvpa mov meptyphyoape mapandveo to mapdbvpo ‘Epyov (Project), to mapdbvpo
Monitor kot o mapabvpo Timeline. To Edius 5mepilapfaver emiong e&eidikevuéva
mapdBupa Yo epyacieg OTmg 1 £yypoen Pivteo kot n dnpovpyia Tithmv.

To mapdabvpo épyov (Project)ro omoio pog emTPENEL VAL ELGAYOVLLE, VO OPYOVMOGOVLE KoL
va amofnkevovpe avapopés mpog to Pivteo . To mopdbuvpo avtd mapovoidlel Tig
KOTAYOPNOES OA®V TOV ‘TNyoimv TAGVOV TOL €1GAYOVUE OE &Va €PYO, OV Kol OgV
ellooTE VIOYPEOUEVOL VL YPNOUOTOMGOVHE KéBe TAGVO TOL €lGAyOoVUE OTO £pYO
poc.To mapdbvpo Timelinepog mapéyetl o GYNUOATIKE GToWT OAOKATPOV TOV £PYOV GOLG,
ocvpumeptlapfavopévev OAov TV Kovalov Bivieo, yov kot vrépbeong. Ot aArayég mov
Kavoope eupavitovtar otnv mpoPfoin Ipoypdupatoc. Ot moAéteg opyavdvovtal Ge
opddeg kat kabe madetdv eppaviletan o Eeywpiotod Topabvpo.To Tapdbvpo Monitor, to
onoio mepthapPavel Tig TpoPoréc mpoehevoelg Kot mpoypdupatog (Sourcekor Program
view, avtictoya). Oa ypnoporocovpe v tpoPoin IIpoéhevong yia vo egetdoovpe
éva pepovopévo Pivieo ko v mpoPoin Ilpoypdppatog ywo va eEetdoovpe v
TpéYovoa Katdotact tov Pivteo mov povtdpovpe oto mapdbvpo Timeline.

H akdrovOn opdda moretmv eppaviCeton emiong €& opiopov oto mapdbvpo tov Edius 5 :
Info:

H moAéta avt) mapéyet mAnpopopieg yio 1o emAeypuévo mAdvo 1 @€ oAlayng mAdvov,
EMAEYLLEVT] TTEPLOYN TOV SLOYPALULATOG POTIG XPOVOL 1} TNV AELTOVPYiD TTOV

exTeAElTE .

History :

H moAéta avt pog emttpénel va eMGTPEYOVLE GE OTOLAONTOTE TPONYOLLUEVT] KOTAGTAOT)
TOV €PYOV, TNV OTOia ONUIOVPYNGALE KATA TNV TPEXOVGH GLVOJO

epyaciog oag. Kabe @opd mov kévovpe pio oAdayr oto £pyo, mpootifetor o kdbe
Kataotoorn oty modéta History. Mmopovue va dtoypayovpe OAES TIG TPOTOTONOELS
HETE TNV EMAEYUEVT] KATAGTOON, VO, ETICTPEYOVUE GTNV TPEYOLGH KATACTOON LOG, 1 VO
EMOVAPEPOVLE GTAOIOKE GE 10YD TPONYOVUEVES KOTAGTACEL -

Effect Controls:

H noAéta avt pog emtpénet vo aAddEovpe Tig puOpicels evog @€ avé Tacd oTiypn Kot
eneaviletal apod epappootel Eva epé og éva video .

Commands:

H moAéto ovt) pog emtpénet vo SNUIOVPYHCOVUE Mo A{OTO. KOVUTL®OV Y1t TIG EVTOAES
OV YPNOUYOTOLOVLE GLYVE KOl VO OVTIGTOLYIGOVLE TANKTPO GUVIOUELONG OE OVTA .
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4.8 "Eleyyog TV pvOuiccov Tov £pyov

Aoy Eexvnoovpe éva €pyo, pmopovue vo eAéyEovpe Tig pubuicelg €pyov avd maca
otiypn. Amd Vv ypopupn tov pevov tov Edius 5 gmidéyovpe :

Project > Project Settings

O1 pvBpioceic £pyov tov Tapabipov dardyov Project Settingpyavadvovtar og

TEGGEPIC KATNYOPLES

General

Ot  pobuicelg oavtég eréyyouv T Bgpelddn  yopakmplotikd  Tov  Pivieo
,oopmeptdapfavopévng g pnebddov mov ypnoiponotei to Edius 5 yio mv enelepyacia
tov Pivteo (Editing Mode),mg évoeiéng ya t pétpnon ypovoo (Time

Display) kat g Baong xpdvov yio tnv mpofoir] tov Pivteo (Time base).

Video Rendering

Ot pvBuiceig avtég eléyyovv 1o péyebog xapé (frame size)mv mowdtnta ¢ ekdvog
(picture quality), qv ovumieon (compression)kot v avoloyio. (proportion) mov
ypnotponotei to Edius 5 dtav mpofddet to Pivieo amd to

dtdrypappa pong xpodvov tov mapadvpov Timeline.

Default Sequence

Ot puOuicelg avTtég EAEYXOVV TO YOPOKTIPLOTIKA TOV MOV OTAV AVATOPAYOVUE TOV MXO
ot TO Oy PO PONIG XPOVOV.

Capture

Ot pvBuicelg avtéc pog emTpémovy va EKAEEOVIE TOV TPOTO LLE TOV 0010 UETOPEPOVLLE
oto Edius 5o Bivieo kot tov Mo angvbeiog amd pio cuokewun Pivteo 1 kapepa.
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4.9 Ewoaymyn ko erelepyocia apyeiov

INo v opa to mapdbupo Epyov (Project)dev mepiéyet kavéva apyeio. o v eicayoyn
KAmolov apyeiov ekOVoG ETAEYOVUE :

File > Importkot otnv cuveyeio to apyeio kot yov mov BELovE. T cuveyeia To apyeio
nov emAé€ape eppavileton péoa 6to projectuog, pe Simhod KMK HEGH GTO EIKOVIO0 TOV
umopovpe vo to avoifovpe pe to Edius 5.To mapdbuvpo épyov (Project)mepiéyet o
neployn Bin n onoia mapovoidlet ta bins o wwodvvapo tov apysiov oto Edius 5).0tav
éva Bin mepiéyer dAra Bin, n epapycn dopn tov Bin eppaviletor oty mepoyn avm
TOPOUOLO, [LE TNV EPOUPYIKN AOTO QUKEA®V KOl VTOPUKEA®V TOL TEPLEYOVTOL GTOVG
OKANPOVG SIGKOVG TOL GLUGTILOTOS LOG -

"o kaOe apyeio mov gledyovle, To Tapabvpo Epyov avapépetol To dvopo Tov (Name),o
tomog pécov (Media) ko n dudpketa tov (Duration).Me dthd KAIK TaveD

og Omo10 apyeio BEAovpe, avtd TpoPdrete Kot oTNV Guvexeio UTOPOLUE Vo TPEEOVUE TO
Bivteo pe to TAnkTpo play,va to otapatcovue Stop,va kivnbodue Kapé-kapé eumpoc ,
Tio® kabmg kot va wailel to Pivieo cvveydueva loop. Avth n dwadikacio yivetal 1060 pe
NV XPNON TOL TOVTIKIOD (IMOUSE)HGO Kal LE TN (PNOT TOL TANKTPOAOYioV.

Me to matnuo tov spacebarmnktpov kavovpe play | stop oe omowdnmote onueio
0élovpe. Eva pe ) xprion tov BeAdv apiotepd Kot 0e&1d, KIVOOUAOTE KOt [LE

axkpifela kapé. Avt ™ dovAELd yiveTon Yo TV €TIAOYT TOL £TBLUNTOD TOV KOUUATION
Bivteo M Myxov N Pivreo kot Myov. To popkdpiopa TOV KOPUATION YivETOL EMAEYOVTAG
mark inkor mark out (enpeio apyng kot télovg ). o mepiocdTEPN

gukoAia matdpe amkmdg to mAnktpo | yio mark inkat to TAfkTpo O yia mark out.Me tov
TPOTO aVTO £YOVLE TO EMBLUNTO KoppdTt Bivieo mov BEAovE .

Me v emloyn kdt® aplotepd, emdeyovpe eniong Pivieo 1 Nxo N kot to dvo pali. Xt
oLVEYELD TOTAOVTAG GLVEYOUEVA TO OPLOTEPO TANKTPO TOV TOVTIKIO, EXAV®

otV €kovo Tov Videoov popkdpape speavilete Eva yepdki, ocvveyilovtac vo mathue
TO OPLOTEPO TANKTPO HETAPEPOVUE TO TAGVO awTd 610 TapdHupo timelinexat

OTNV GLVEYELD TO EMOUEVO KOl TO EXOUEVO KTA . Mg OV TpdTO 0wTd YTilovpe o €pyo mov
Bélovpe va Kavoupe.

H tonobémon oto mapdbvpo Timeline yivetan oto Pivieo 1 (Video 1).Otav avoiyovpe
apyucd to Topabvpo Timeline,avtd eppavilel tévte Eexmplotég ypaupés ,

To amokaAoOpeve kavaiio (tracks)kdto and tov yapoko pétpnong xpovov. Ta Kovaiio
AELTOLPYOVV GAV YDPOL LITOGOYNG YO TO TAGVOL [LOG, XPTCLLOTOUDVTOG

TOALOTAG  KOVAAL TOKTOMOLOVTOG TO TWAGVO HEGH OTO  KOVAALL, ONUIOLPYOVUE
aAAnAovyieg eOVOV Ko EQE, TO OTOL0 TEMKA PETOOYNLOTICOVTOL GTO TEMKO HOG

Bivteo. Mnv Eeyvape 6t 0 mepiBaiiov mov emaé&ope vo dovAéyoupe ivor single track
editing Mg tov tpémo avtd yivete 10 yTiGYo TOV £pyov EMAEYOVTOG TV aAlnlovyio Tov
0élovpe . Evod yuo v goaymyn nyov kdvovpe mdAL Ty 1010 dovAEd, TomofeTOVTOC
oG Ta TAGva vt og e GAAN 0éom ota track positionsTa midva mov TomofetovvTon
oto mapabvpo TimelinenpoPdAiroviar 6To PHOVITOP TOL TPOYPALLUOTOC.

2tV mepintwon mov avtd dev eivarl opatd emAeyoOUE SO0 IKA

Window > Monitor

LLE TOV TPOTO 0VTO EMAEYOVLE Kat 0moio dAlo mapdbupo Bélovue 6w transitions, video
& audio effectscon omoio GAlo ypelacTovuE.
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4.10 Ep@dvion €vog £pyov o€ MPOETIGKONN G 6TO TO.PAOvpo
Monitor

[No va dobupe mwg eéediooetor m epyoacion pog , UTOPOVUE VO EUEAVICOVUE ©E
TPOEMOKOTNON €évo N MEPLocOTEPO TAAVO oT0 mapdbvpo Monitor. Xtnv koatdotoon
Autinig IpoPoing (Dual View),to mapabvpo Monitor eppavilet i mpoforés
[poéievong (Source)xkot [poypdaupatog (Program).H wpofoin Ipoéievong (Source),
oTNV 0ploTEPN TAELPA TOL TOPaBOPOL, HoG emTPENEL Vo eEgTAoOVUE €V TAGVO OF
TPOEMOKOTNON, Vo T KOWovue ( trim ) kot kotomy vo. 10 glodyovpe 610 mopabvpo
Timeline. H npofoAny avt) pmopel va amobnkevel moAAG mAdva, OAAG PUTOPOVUE VL
e€etalovpe Ko va Tpocapprolovpe Hovo £va TAGVO ove TooE oTiyun .

H mpopoin Ipoypaupatog ( Program )om d6e&ié mievpd Tov mapafvpov, oG emtpénet
vo €EETAGOVE GE TPOEMOKOTNGT OAOKANPO TO £pyo pag (oTo TeAKO Pivieo ) avd macd
otryun . H mpoPoin avtm epepavifetor v aAiniovyia tov tAdvov mov Ppickovtaol emi
0V TOPoOvTog oto mopabvpo Timeline. Mropobue emiong va ypNOLUOTOIOVUE THV
npoPoin Ipoypdaupatog yio vo fAémovpe tig emioyég play —stop — loop — mark in — mark
out .

Epdoov yiver n emdoyn tov oknvav mov Béhovpe kol tomobetnBovv oto mapdbuvpo
Timelinetic teplocdtepeg Popég xpelaleTor va KOWYOLLE Kot va. pyovpe

TOAAEG OopEc, axopa péxpt to emBountd omotéieoupa. Avtd yivere ywti yoo vo
dnuovpynoovpe oknveg, kKoyiuata (Cut) kot epé adldayng Thdvou (transitions)Pa

npénel va. kOPovpe (trim) to mAGva pag yuoo Voo avolpoOUE TO HEPT OV OF HOG
yperdlovtat. H kom tov mAdvev givorl éva onpovtikd 6tddlo ot dadikacio
onpovpyiag evog Pivieo JTa kabBapd Tpocmmikodg pOLOVG Kol £0M EMAEYOVUE TIG KPO
OALOYEC VAL TIG

Kavovpe oto mopdbvpo Timeline. Tomobetdvtog tov kabeto Yapaka tov Timeline oto
onueio mov BEAoVpE Ko TOTOVTOC TO TANKTPO Space bapiémovpe v avoroapoaywyr Tov
épyov pog and to onueio ekeivo, pe 1o maTUo EAvE ToL 1010V TANKTPOL TO GTOUATALLE,
emiong pe v xpnomn Tov PeAdv aptotepd deE18 TPOXWPALE

pe Puo kapé kapé I vo kOyovpe amd to devTEPO MAGVO m.y. 9 devTEpQ, EMAEYOLLE
TPOTO OO

OA0 O TO €1KOVIO0 TTOL PpioKeTOl KAT® aploTepd, xpovo avdivong oyt 4 devtepa mov
gtvait 0 apykdg xpovog mov opilel to Edius Sodrd 12 framesyie tov tpomo

aVTO £YOLUE UEYOADTEPN OvEALGON Gpo Ko peYoAvTEPT akpifela. Xtn cvveyeio apov
TApE TOV KEPCOPO TOV XAPAKO GTO ONUEID TOV BEAOVE VO KOWOLLE, EMAEYOVUE OO TNV
opada epyareimv mov Ppiokoviol Tave aploTePE GTO

Timelinetv tekevtaio emA0YN TO EIKOVISIO TNG CLUYKEKPLUEVNG AELTOLPYING.
Emiéyovtag to tomobetovpe 610 onpeio ekeivo Tov YOpaKa OV EMALEALE KO TOTAUE
KMK. Mg tov TpOTo anTd KOTNKE TO TAGVO, EMAEYOVTAG GT] GLVEXELD TO EIKOVIOLO [LE TOV
JelkTn TOVTIKION EMAEYOVUE TO KOUUEVO TAAVO Kot ooy ovtd emileyei, matdue delete.
21V mepintoon mov BEAOVLE VO KOWOLUE HOVE TV €IKOVA 1 TOV MX0 Kot Oyt Kol To SLO
padl amd v opdda ewcovidiwv mov Bpicketon de&1d STl
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oto time zoom levelemileyobue 1o ekovidio toggle sync modeye tov tpdmo owtd
EMAEYOVLE VO TPOTTOTTOLOVE Pivteo N Nyo aveEdptnta. o v KaAvyovpe To KeEVO TO
omoio dnuovpyndnke eite petokvovpe 10 €mOpEvo mWAGvo otn 0éom Suthd oo
TPOTOTOMUEVO €lTE dpa Exovpe va peyaio TAN00g and TAGVO 6T cuVEXELD TOV

épyov ko glvar dGVOKOAO VO LETOKIVOOUE OAoL €va — €va, eMAEYOLUE amd TNV OUdd
ewovidiov mive aprotepd to M ( multi track select tool e Tov tpdémo avtd pmopovue
Vo HETOKIVIOOVUE OA0L M HEYOAN OpAdo TAGVOV Yoo TNV KGALYM TOL KeEVOD TOL
dnuovpyndnke.
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KE®AAAIO 5

5.1 Rolling, Ripple , Slip Edit

To epyareio avtd pog emTpénel vo. Totoovpe Kot va tpofnéovpe to edit line evog
TAGVOV Ko TaTOYpOVe v oAAGEOLLE Ta onpeia 16000V Kot ££600V TOV

emopévov mhdvou oto edit line.Otav to kdvovpe owtd, 1 S14pKELD TOV ETOUEVOV TAGVOL
avtopata Oa enelepyootel yio vo avtiotaduicel Ty oAdoyn TOL ETOUEVOL

mAdvov. o Topadetypa, edv mpooécovpe névte framesoto mpdto TAGvo, mévte frames
Ba avapeBovv and To endpevo. ‘Etot to epyoireio owtd pog emTpénetl va

emeepyaoctovpe éva mAAVO yopic vo ypelootel va oAAdovpe TV O1dpKE TOV
npoypappatos. H dwudikacio etvat:

Yty 006vn Oa wpémel va Exovpe Eva pProjectavorytd pe TOLVAGYIGTOV VO TUPUKEIUEVDL
mAdva og éva koppdtt videooto mapdbupo timeline. Tlatdpe to epyodeio rolling editywa
va 10 emAéEovpe N motdpe N 610 TANKTPOAIY10.

Metakivobye to rolling editoto edit lineavdpeca ota dvo mapakeipeva TAGVA.

[Motdpe kon tpafdpe pe emreypévo to epyareio 0e€ld 1 aplotepd yio vo eneEepyacToOE
Ta TAdva. Av Tpafnéovpe 6e&id, Ba empunkivvovpe 1o onpeio e£660v

TOV TPOTOV Kot B LELDOCOVUE TO ONUEID €GOS0V TOV TOPAKEIUEVOVL. AV TOTCOVLE GTO
aplotepd , o perdoovpe To onpeio ££600V TOV TPAOTOL Kot Bal EMUNKVVOLUE TO

onueio €160d0v T0V devTéPOov.To epyareio avtd pag emrpénetl va enelepyactodue Eva
TAGvo yopic va emnpealovpe éva mapakeipevo. v ovcia to ripple edit sivor to
avtifeto tov rolling edit. Otav motdpe Kot TpaPape e TO TOVTIKL Y10 Vo EXUNKOVOVUE
10 onpeio £630vV evOg TAAVOL, TO TPOYPOAUUO «TELEW TO EMOUEVO TTPOS TO OEELE Yo VL
amo@VOyovpe aldayn oto onueio 1d6dov Tov. Etot, dnuovpyodvtag éva g ripple oe

oA TN Topaywyn, oty ovcio aALAlEL TNV ddpKELD TOV. AV TATHGOLUE Kot TpafnEove
TPOG T OPLOTEPE Y10 VO LELWGOLVE TO onpeio eE600v, To Tpdypappa dev

aALGCel Ta onueio €16600V TOV EMOUEVAOV TAAV®V, aVTIBETOC Yo va avtioTaduiost Ty
aAdhayn pkpaiverl Ty dtdpketa g akorovdiog.

H dwdwoacio etvat:

Yty 006vn Oa mpémetl va £xovpe éva projectavolytd pe TovAdyloTov Vo TAGVL EVOUEVA
Gipn pe dxpn og éva koppdtt videooto mapdabupo timeline. Ilatdpe

10 gpyaieio ripple editywo va to emléEovpe 1 matdpue B oto minktpoArdylo.Metokivodue
10 gpyareio oto onueio €600V ToV TAAVOL oL TpdKkelTol va eneEepyactovpe. [latdpe
Ko Tpafape pe to movtikt oto deEId Yo voL avENGOVUE TO

LUMKOG TOV TAGVOL 1 TPOG TO. OPLOTEPH Y10 VO LELWCOVUE TO Pfkog Tov. H didpkela Tov
EMOUEVOL TOPOUEVEL 1 1010, OAAG M) didpKela TNG okoAovBiag £xel aAAAEEL.

To epyadeio avtd pog emrpémel vo aAldEovpe too onueio €16000v kot ££000V €vOG
TAGVOV IOV etvar avapesa o€ dvo AL, S10TNPOVTAG TNV JEPKELD TOL HEGAIOV

¢ €xet. Otav motdpe kot tpofdue 6to TAAVO, TO YEITOVIKA TOL de&1d Kol aploTepd Ogv
aALalovv, €Tt ovte aAlalet Kot 1 dudpketa g axoiovBiog. H dwadwaocio givar:

Yty 006vn Ba mpémer va Eyovpe Eva projectavorytd pe TovAdylotov Tpio TAGvVA TANL-
A og éva videokoppdtt 6to mopdbupo timeline. Ilatdue to epyaieio
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slip yio va 0 emAé€ovpe 1 matdpe Y oto mAnktpordyo. Me emideypévo to gpyaieio,
TATAUE 6TO TAGVO TToV lvar oty péon Tv dvo AAlwv. ['a va adddEovpe ta onpeia
€16000V Kot €£000v Ywpic va arldéovpe v dudpkelo TG akoiovding, maTdue Kot
tpofdpe aprotepd Kot de&id.

Onwg ko to slip edit,to epyaieio awtd enelepydleton to pesaio amd ta tpio TGV 6TV
axoiovbia. To slide editdiotnpei ta onpeia 166500V Kot £6S0V TOV

TAGVOV TTOV TPUPAUE LLE TO TOVTIKL KOl GLYYPOVDG dALALEL TV O1APKELD TOV TAAV®V TOV
KataAnyovv og avti. Otav tpapdue ota de€ld empunkvvovpe 1o onueio £660v

TOV TPONYOLHEVOL OTMG €MioNG Ko TO onpeio €160d0v tov gmopévov. TpaPfmdvrag
apLoTEPG GE £V TAAVO LEMVOLLE TO oNUEI0 ££000V TOV TPONYOVUEVOL OTIMG EMIONG

Kol T0 onpeio 16000V TOL EMOUEVOVL. ZaV OMOTEAECUO EXOVUE M OBPKELD TOV TAGVOV
aALA Ko 0OAOKAN NG TG akoAovBiag va unv aAralet. H dadwcacio ivon :

Yty 000vn Ba mpémer va Eyovpe Eva projectavorytd pe TovAdylotov Tpio TAGvVA TANL-
mAdt o€ éva kKoppdtt videooto mapdabupo timeline.Ilatdpe to epyaieio

slide yw vo to emié€ovpe M matqpe U oto minktpoAdyto. Tlotape kot tpafdue oto
HeGaio €K TOV TPLOV TAAVOV Y1 VoL TO petakivioovpe. Tpafovtag apiotepd

LUKPOLVEL TO TTPOTYOOUEVO KO LEYOADVEL TO €mOpeVO. Tpafmdvtag de&1d peyoaldvovpe o
TPOTYOVUEVO KOl LUKPAIVOVLE TO EMOUEVO.

5.2 Eneepyoaciao 1y0v Kol E160yMY1] HOVGIKAOV aPYEi®V
File > Import >emdoyn apyeiov.

H dwdikacia eioaywyng kot tpomomroinong oto £€pyo pog yivetor 6nwg kot otig Pivteo
EIKOVEG TTOV ELCNYOUUE EMG TAOPOL.

[Ipocéyovpue dote N Nyoypdenon pog vo yivetor pe apyd kot kaboapd Adym Kot o TOvog
OV XPNOILOTOOVUE Vo gival o 1010¢. Emileyode eniong va tomobetricovpe tnv agnynon
nog og Egymplotd kavar (track)yia kakdtepo Eleyyo kat dtoympiopd.

21 ocvveyeio Kot EQOGOV TO AMOTEAEGLOL LOG IKAVOTTOLEL ETIAEYOVE KOl EIGAYOVE KO TOL
LOVOIKA Koppdtio Tov 0EAovpe va vtdpyovv 6to £pyo pag. ' va

yiver autd wpémel ta apyeiot YOV CVTA VoL VITAPYOLV GTOV VITOAOYIGTY| HOG, OV gV Elvar
070 6KANPO pog dioko Oa mpémet va ta eicdyovpe. Enedn opmg to Edius 5

pumopet kKo emeEepyaletor cvykekpilpévo ToAo apyelov, Oa mpémel kol epeic vo ta
amoOnkedovpe 6ToV 1010 TOTO aPYEi®V. XTO CUYKEKPLUEVO £PYO EMAEYOVUE apyEio

nyov MP3.
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TRO4

Shade Line Chroma IRE

[a v ewoayoyn Kot TV UETATPONY] TOV HOVGIKAOV opyeimv YpNoYOTOloOUE TO
npoypappa Audio Galaxy,mpokettot yuo évo mpodypappa eneéepyaciog Nyov Ue To 0moio
pmopovpe ETEUPOVUE GE OTOLAONTOTE GNUEID TOL Ko TETHYOVE MPOiat

NYNTIKE OmOTEAEC AT,

Metd v €160 y®yn TOV apXEi®V 0LTAOV GTO NAEKTPOVIKO VTTOAOYLOTY] , TOL OVOTYOLUE LE
to Edius Sue mv yvoot dwdikaoia : File > Import >emioyn apysiov

Ko To. Tomobetodpe og éva kavdAl audio trackEmeidn oty gpyacio avt tepEYovpe :

1. Xvvévtevén
2. Movoikn

ypewldpaote mopoamaveo amd éva M dvo audio tracks.Avtd to kavovpe OGO Yo va
EYOuLE OLOYMPIGUO TOV YOV TOV YPNCLOTOIOVUE, OGO KoL Y10 KAADTEPO EAEYYO.

5.3 Ewaymyn audio tracks

I v eloayoyn tepiocotépov audion axoun kat Bivteo trackskavovpue 1o
egig:

[Mnyaivovpe oto mapdBvpo timeline tov Edius ot axovpndviog tov Képoopa Tov
ToVTIKIoV pog oTig maAéteg tov videokor audio trackspe de&i Kk emdeyodue add audio
track Mg tov tpomo avTd pUmopodLE VO ELGAYOVUE EMTAEOV TAAETEG YOV KOl EIKOVAS .

A@ov oroxkAnpwlel ko M dwdwkasio E10aYOYNG TNG HOLGIKNG HOG KOl ETAEYOVTOG
VATOPAY®YT TOV £PYOV HOG, GLVEWONTOTOOVUE OTL TO MYNTIKO OMOTEAEGUO OV WOG
KOVOTIOLEL, €1TE EMEWON 1 LOVGIKY| VITEPPaivel TNV Evtaom TG

aenyNong, €ite yoti 1 cuvévievén 6ev aKoVYETOL KOAQ 1 OKOUN TO OTOTEAEGLO NYNTIKA
dev pog apéoet. ['ia Toug Aoyohg avtovg ypetdleTot va enelepyacTodE TOVGS

Nyovg mov ypnowomowovpe. To Edius 5 pag diver apketovg tpdmovg €AEyyov Kot
Tpomonoinong TV NYwv pogc. [Ipdtog and avtov sivarl ) xpron tov Auto Gain.
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O deltePOg KO TOAD TO10 €0YPNOTOG TPOTOG €ivan pe v ypnon tov Audio Mixer.
[Mpoxertar yo Eva ToAd kakd epyodeio Tov Edius Sue to omoio

UITOoPOVUE VO AVEOUELDMCOVUE TOV YO LOG GE OTOONTOTE GNUEID TOV KOt TaLpAAANAQ VoL
eréyyovpe Vv otdfun tov. Emtheyodpe dadoyikd :

Window > Audio Mixer

Audio Mixer pmopodpe va pubuicovpe TG TOPAUETPOVG AEITOVPYiRG TOL. ATO TIg
emoyég Display Optiongmideyodue v mpotn Audio Mixer and Master Fader.

Me tov tpomo avtd £xovpe Eleyyo Tov Kabe KOvaAloD, 0G0 Kol €VOG YEVIKOD Ogiktn
otdOung tov Nyov pag. Evd yuo to dedtepo Automation write optionsmikeyovpue to
OebTEPO e TO OMOI0 O CVTOUATICUOS EYYPAPETOL KOTO TN OWIPKEW Kol UETE TNV
petakivnon Tov controloe véa Béom. v e@opproyn Hog ETAEYOVUE TPio, KAvAALo

audio trackeo omoia To TEGGEPQ AVTIGTOLYOVV :

1. Xvvévtevén

2. Movowkn

Onwg ota mapdbupa vrépbeong Pivieo eiyoue ta Display opacity rubber bandsiot kot
ota Audio tracksoto mapdabupo timelineemieyovpe and to yaAdxt wov

vrapyel aimhd oto kéBe track to Display Volume Rubber Banddle tov tpdémo avtd
UTTOPOVLE VO VEOUEIDGOVE TNV £VTACT] TOV YOV LAG, XPNCULOTOLDVTOS TV

KOKKIVT YPOUUT Y0V, 1 omoia petafarel TOGO T0 aplotepd 0G0 Kot 6TO deE KavAaAl
Nnyov. H emAoyn Display Pan Rubber Bangsg enttpénel tv aAlayn gite Tov apiotepov
gite Tov 8e&100 KavaAloD Nyov, 0AAG emedn pe To ovykekpipuévo Camceordettov £yve M
eyypoon etyape Eapiopévo Nyo, OnAadn eyypaen o€ Eva

HOVO KOVOAL ETAEYOVUE KO YPTCULOTOIOVLE TNV TPAOTY EMA0YN. Me Tov TpdTO avTd TO
npoypappa Swfalet (read)rig ardayég mov KAVOLUE Kot TIG 0KoAoVOEL ovTdpaTa.

Me v ypfion emiong tov Display Volume Rubber Bandggvovpe mv évapén i to
tedelmpa TG aprynong va givar moto opadr). No unv praivel amdtopa €ite 0 AOyog

elte 1 povokn pog .

Me v yxpnon tov avtopaticpod o gyypaen (Automation write) ,kdfe popd mov
ocOpovpe to control oe véa Béom kou emdeyodue avamapaymyn (play) avtd avtopata
eyypoeet Tov Nxo otnv évtaon avt. Me tov tpdmo avtd pmopovpe pe v avéopeioon
Tov controlva aAhalovpe Ty Evtaon.

Etvon moAd onuoavtikd o Nyog va eivon apketd Kaddg ywo vo punv Lopiletatl oto dkovoua o
Beatc. Oa pémel n apnynon va eivar duvatdtepn o€ £vTaon amd TV LOVGIKY.

5.4 Mién xon onuovpyia epé pe to Audio Mixer

Ye éva oToLVTIO MYOYPAPNONG O TEYVIKOL ¥PNCILOTOLDVTOS TNV KOVGOAN MENG Hmopohv
VoL EAEYYOLV KOl VO OVOTTOPAYOVV HOVGIKG KOUUATLOL XTO TPOYPOLLLLOL

OV YPNGLLOTOLOVHE UTOPOVLE VO ONLLLOVPYNGOVUE o WEN YOV YPNOUOTOIDVTAS TO
audio mixer m&Gpwvtog £T61 NYOVG OO TO PEYIGTO TEVTE LOVGIK®OV KOUUATIOV

og éva peydAo povolkd koppdtt (mastern olimg pmopodue vo mpocbicovpe eé og
OpLGHEVO KOUPATLO ameVBeiog ypnoiporoldvTag To Submixkoppdrt, to omoio pmopel

va odnynbet oe éva masterkoppdtt. Onmg (o emayyeAUATIK] KOVGOAO WIENG HOG
empémel vo pvuicovpe ta emineda Tov Nyov, v e&acbévnon tov (fade in-fade
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out), va eléyEovue ta €9é k.T.A. Emiong pog emitpénel vo nyoypapicovpE NYovg, vo
OO LLOVMDGOVE £VOL KOUUATL KOL VOL TO 0KOVE SOl0,evd to aAld mailovv.

Automation

O emoyéc Tov automationuag divovv v dvvatdTa va

TPOYUATOTOM GOV HE (i piEn fyov. Tlapodia avtd dev Ba pmopécovpe vo 10 ETTOXOVUE
aVTO €AV TPOTO deV KOBOPIGOVE COOTA TIC EMA0YEG TOL KAOE KOUUATION

Eexoprotd oto audio mixer.I'io mopddetypa, Yo vo. NYoypPoeNCOVUE EVO. KOUUATL OF
keyframestpénel mpota va puOpicovpe tig emAoyég Tov automation (write, touch

7N latch). Apov kdvovpe avtéc Tig pubpicelg kot otapaticovpe to playbackor pvbpiceig
avtég Oa amewcovifovtan and keyframessto mapdabupo timeline.Ot

emloyég Tov automatioreivou:

Write:

Apeca amoOnkever 11c pvbuicelg mov €xovv yivel oe €va KOUPUATL Kou Ompovpyel
keyframessto mapabupo timelinedmov ameicoviler Tig nynrikég pvbuicers.

Latch:

Onwc ko pe v emloyn Write, amobnkevet tig pubuioeic kot dnuovpyei keyframessto
apabupo timeline. Ouwg to automatiorbev Eekiva uéypt va apyicovpe va

Kavovpe T1¢ pubuioeis. Evrovrtolg, av alda&ovue tig pubuioeic (6nwg v éviaon) otav
AVOTOPAYEL £VOL KOUATL TOL £xEl N Nyoypaendei oto automationpt

PLOUUGELS EMGTPEPOVY GTO TPONYOVUEVA ETUTEDQL LEXPL VO Yivouy VEEG puOuicELC.

Touch:

Onwc kar pe v emioyn latch, tapayel keyframesoto timeline kot dev mpoypatomotet
pLOUIGELS LEYPIS OTOL VA YIVOUV 01 OALAYES TOV TILADV EAEYYOV.

Read:

Avamapdyst v pobuion automationkdde koppotiod, OmOG TNV €viOcn KOl GTNV
OVOTTOPOYOYT LTOPOVUE VO KOVGOVUE TNV CAAYT OLTH KOt VO TNV d0VUE OTNV £VOELEN
VU.

Off:

Axvpavel 0mota puOpIoN BELOLLE KOTA TNV AVOTOPOYOYT.

Ta xoopma MUTE, SOLO, RECORD

Ta kovpmd avtd pog emTPETOVY v EMALEOVUE e TOLO HOVOIKO KOoppdtt BEAovpe va
JOOVAEYOVUE KoL [LE TTO10 OYL, EVD HOG EMLTPETOVY VO, KOTOYPEWOLLLE KO

OVOAOYIKO KOUUATL 0 pukpOemvo. To mute kovuni pog emTpENEL VO GLYNCOVUE £Vl
KOUUATL KOTd TNV
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AVATOPAY®YT. XPNOLUOTOIDOVTAS TO MUtepumopovpe va BEGovpe Ta emimeda TG EVTAONG
TOMOTAGDY KOUUATIOV Yopig va akodue to vrorowra . To SOlo kovuni pog enttpénet va
OTOLLOVGOVLE KOl VO SOVAEYOVLIE [E £VOL

CULYKEKPIUEVO KOUUATL 6to audio mixer,evd TopdAANAo UTOPOVUE VO OKOVUE KoL TO.
Ao Koppdrio.

To recordkovpni pog divel v duvatdtnTo va Kataypdyovpe Kot va 0Ecovpe To emineda
Tov Myov pe o audio mixelTa kovpumd eréyyov PAN koar BALANCE

To kovuni pan pog emTpémel Tov EAEYY0 TOV HOVOPOVIKOV KOUUATIOV OTOV KOVOLLE
¢€odo o¢ stereoq 5.1kxoupdrio.

To kovuni balanceuog emtpénel va wooopomcovpe kot va avadiaveipoops mv €£080
nyov og stereacat 5.1xoppdrio. ‘Etot, 0nmg mpocHétovpe 610 nymTikd enimedo

TOV £VOG KOVOAL0D, OVOLPOVUE Atd TO GAAO KOVAAL KOL TO OVTIGTPOQO.

ENTAXH (VOLUME)

Avepalovpe i katePfdlovpe v £vraon Tov fxov og decibels.

ANAIIAPAT'QI'H (PLAYBACK)

Yndpyovv €61 emdoyég oty avorapayoyn: stop, play, loop, go to in point, go to

out point, play in to out. Moavtég pmopovpe vo enelepyacTovpE £va KOUUATL OTTMG
Bélovpe.

5.5 Anuovpyovrag Submix

O audio mixeruog emtpénel akOUo VO GUVIVAGOVIE NYOVS OO SLOPOPETIKA KOWLLATLOL
oe évo koupdtt vmopiEng (submix). Ag vmoBécovpe Ot €xovpe TEGGEPA MYNTIKA
KoppdTio Ko OEAOVUE VO EQOPUOCOVUE T 10100 €PE OTAL SLO OO TO KOUUATIOL OVTE
Tautdypova. Xpnowonowdvtag tov audio mixer, pmopodue va 0dnyfoovpe ta Vo
Koppatio og évo. SUbmixxoppdrt kot vo EpoprOGOVLE TO £QE GE

avto. H dwodikacio etvon n e€ng:

Snuovpyodue évo submix emiéyoviog sequence > add trackzo mapdbvpo tov add
tracksminktporoyovue 1 oto nedio add audio submix trackKro pevov track

type, emtleyovpe ov to submixxoppdtt BEhovpe va gival HOVOPOVIKO, GTEPEOPMVIKO 1|
5,1. %10 vroroma edio TANKTpoAoyoOE O yia vo unv Tpootefodv aAld KOPUATLO.

Y10 mapdBvpo tov audio mixer,Bétovpe ™V €060 yio o Submit koppdtt av gival
amoapaitnto. Oétovpe ™V ££000 EeY®PIoTA Yoo OAO TOL KOUUATLO TOL BEAOVLE VO
odnynbovv oto Submix kopudtt oto pevod &EG60LV  ©6T0 KAT® UEPOG  TOL
koupotiov.Extléyovpe ta @€ yia to SUbmixkoppdrt, Totdvtag og £va and o IKovidla
TOV EPE

(tplyova) kot ta evepyomolodue.

Balance:

To Balanceypnowonoeitar yio vo. oAAGlel v évioon oto apiotepd kot 1o de&i Kavait
TOV YOV VOGS PBivieo Ko EVOALXYT GTNV OVGIO TOV SVO KOVAALDV.

Band pass

H p0Ouion Band passivat oty ovcia éva @iIATpo 0Tov UmopEic Vo TO XPTGLLOTOGELS
Y0l OTOKOTT) GLYVOTHTOV TEPO ATO TNV OTAVTO GLYVOTHTMV TOL

B€LovLe VoL XPNOLOTOGOVLE.

Bass:
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H pvOuion Basseivor éva @iltpo mov ypnowomoteiton yio v pvbuion tov moAD
yauniav cvyvomtov (200hzko kdtw). Y ndpyet kou 1 emhoyn Boostonon

EVIOYVEL TIG TTOAD YOUNAEG GUYVOTNTES.

Channel Volume

Xpnoporotovpe to channel volumega v pvuion g évtaong Tov KavaAlod Tov o
oe stereoy 5.11M og povoka koupdria .To channel volume

EAEYYEL TNV £VTOOT EVOS KOVOAOV oveEApTNTOL Ao TO AAAG KOVAALAL.

DeNoiser:

To denoiser avtopoto amopakpivel 10 BopvPfo amd Evav avoroyikd Myo Tov
xpnoyomolovpe. 1o moapdbvpo custom setupumopodpe va pvOuicovpe oplopéveg
TOPAUETPOVG OL OTOlES Elval:

Noisefloor.

Mo deiyvel o péyebog tov Bopvfov tov TAdvou pag ce decibels

Freeze

[Matdvrog To freezecvykpatovpe v €080 tov noisefloorotv T mov £xet ekeivn v
ypovikn otiyun o decibels.

Reduction

XpNoHomoldvtag 10 EAEYYovE To T0Gd Tov BopvBov mov BEhovue va aparpécovpe. H
neployn eivon -20 émg 0 o decibels.

Offset

Avtdg o éleyyog Oétel o i offsetn meployn yia amopdvoon Bopvfov petacd ™g
TG mov €xet to noisefloorkot twv Tpdv and -10ko +10c¢ decibels.

Delay:

Xpnowomotovpe to delay ywa vo dnupiovpyfcovue éva gpé Nyov 6mov Ba gppavileton
LETG TNV XPOVIKN otiyun 0mov &yovpe opicel o¢ mepoyn delay. To feedbackivatl to
TOGOGTO TOVL NYOL TO OTOI0 EMOTPEPEL Tio® otV Tepoyn delay. Xpnoiponoovpe v
EMAOYN QT Y10 VO SNLLOVPYHGOLLE [ 6Epd omd delaynyd

(Mo kabvotépnong). H emdoyn mix ypnoipomnoteitat yuo va kabopicel To mocd g Nyd
mov Ba gpeavileton o Eva NyMTIKO QL.

Dynamics:

To gpé dynamicstopéyet pio TotkiAio ETMA0YGV Yo TNV pOHOUGT TOL YYOV.

Ot emAoyéc avtég elvat:

Gate

AVTOC 0 €AeYX0G QMOKPIVEL T [N XPNCUYLOTOIOVUEVO, GTLLOTA YOV OTAV TO EMIMEDO TOVG

TECEL KATM 0o TNV Tiun ov €xet n emhoyn threshold €otdtato 6pio)

oe decibelsOtav 10 onua mepdoet tépa and v Tiun thresholdtote n emhoyn attack
kaBopiletl To ypoviKd StacTNUA Yo va, avoiEeL 1) TOAN. AV TO GYjUa TEPAGEL

népa amo to thresholdy emdoyn releasecabopilet To ypovikod didotua yio va kAeioel 1

TOAN. Av TéA0C T0 onua mécel katm and to thresholdrote n emdoyn hold

time 0o, kabopicel m0c6 ypovo N TOAN Ba Tapapeivel avoryty.

Compressar

Emyepeil va 1coppomicer 1o dynamic rangesvog mAGvov, evioyDovTag To «Omold»
NYNTIKG ETITES QL KO LELDOVOVTOG TO «duvarta» enineda. (to dynamic range

givort ) Tepoyn amd 10 VYNAOTEPO EMIMESO GTO YOUNAOTEPO EMLTESO TOV 1YOV).
Expander:
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[Moapdyet éva epé Aemtig mOANG divovtag onpato Nyov mov givor yoaunAdtepa omd
otéOun thresholdot pvOuon ratio @voroyia). Mia pdBuion ratio 2:10a emunkdver mv
ueioon and ldboe 2db.

Limiter:

Mog emutpémel vo ovolp€oOvpe KOPLOEG NYOV Ylo. VO UELWCOVUE TO WOAISIGUOL.
Xpnoorotovpe tnv emioyn thresholdyio va eléyEovpe 10 péyioto eminedo tov
onfuatog. Xpnoyomowbdue v emdoyn release timeywo va 0écovpe tov amapaitnto
XPOVO Y10, TO KEPAOG Y10 VO TEGEL GTO PUGLOAOYIKO EMIMEDO UETA TO YOAOIIOUOL.

SoftClip:
Onwg ko 1 emthoyn limiter peidvet to yaAidiopo 6tav 10 GNUO KOPVPAOVEL.

EQ:

To gpé EQ pewdvel 1 evioydel ocvykekpluéveg meployég ovyvotitov. Eivar dniadn éva
equalizer(cootddiong) omov mePLEYEL TPELG UTAVTES GLYVOTHTAOV :

yopnAn, pecaio kot vynAn. Ot emAoyég Tov elvat:

Frequency

Xpnowomoteital yuo TNV avénon 1 v peiwon cvyvortrag peta&d 20kor 2000Hz.

Gain

PvOuon tov képdovg petald -20kon 20db.

Cut

Evailoyn youning Kot vyniAng umavtag, OTov Propel vo amokpivel 1 vo KOYEL £vol G UaL
o€ 0PIoUEVEG GLYVOTNTES e TNV Pfondeta pidTpwv.

Q:

KabBopilel to unrog mov o ypnopomombei 1o @idtpo peta&y 0,05kan 5,0 oxtapeg.

Fill left:

Avtiypagel tov Myo oto el kavdAlr Stereo kot To pPETOQEPEL OTO  APLOTEPD,
AVTIKOOIGTAOVTOG TOV TPOTYOVHEVO X0 TOL KOVOALOV.

Fill right:

Onwc axpipac to gpé Fill left.

Hihgpass

Amokofel cuyvotnteg mhve amd tnv cutoff cuyvotno.

Invert

Avtiotpépel TV pdon Tov Mxov Tov KaBE KavaAlov

Lowpass

Amoxoel TIg oVYVOTNTEG KAT® amtd TV cuyvotTa cutoff

Multiband Compressor

XPNOUOTOIOVUE QTN TNV EMAOYN Y10 TNV GLUTIECN YOV CLUPOVA LE TIG TPELG PUTAVTEG
TOV OLVTOTOKPIVOVTOL OTIG YOUUNAEG-IEGOUEC-OYNAEG GLUYVOTNTEC.

Multitap Delay

H emiloyn aut Hog ETITPETEL VAL YPTCLUOTOCOVUE TECTEPLS KOBVGTEPNOELG

vy tov éheyyo TV ovvoAlkd delay gpé. Xpnowonowwviog ta delayl puéypr delayd
g éyyovpe tov ypovo evog delay. T v dnuovpyia molhamiav delay g,
yponotporolovue ta feedbackluéypt feedback4.

Notch

XPNGIUOTOIOVUE TNV EVTOAT OTH Y10 TNV OTOUAKPVVGT

Boppav kat aAlov BopoPov.
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Parametric EQ

Mo emttpénel vo, EVIGYVCOVUE 1] VO LELWCOVE Lo cLYVOTNTO 1] omoia glval dimha otV
KEVIPIKN GLYVOTNTO.

PitchShifter

Elvar éva epé mov pog emrpénet voo oAAGEOLE Lot KOPLPT EVOS GNUATOG, EOKA OTAV
Bélove vo Tapdyov e po ALy GTOV X0 OpUALNG.

Reverb

H emloyn avt) pog emtpénel vo TpocHEGOvE avTyNoN GTO GNUOL LG ,0VOAGY®S TO
neplPaAlov mov gpeig BELoVLE VO SDGOLLLE TNV EVTIOTTOOT OTL

poépyetal o Nyoc. Ot emhoyéc Tov glvar:

Predelay

Me avti v evioA] e£opouUDVOLUE TOV XPOVO TTOV XPELALETAL O 1)XOG VO YTUTNGEL EVOV
TOLYO KO VO EMGTPEYEL TC®

Absorption

O¢teL TNV AmOpPOENGN TOL MOV

Size

O¢teL 10 péyebog tov Ydpov o mMocootd %

Density.

O&TEL TNV TUKVOTNTO TNG “OVPAC» TNG AVTINYNONG

Swap Channels

Kaver evailayn tov kavoov

Treble

To gpé avtd pvOuilet Tig ToAd vyMAég ovuyvotnteg (4000HZKo TaV®)

Volume

To ovykekpipévo €0 amotpénel TV SoTPEPA®ON TOL YoV dTav ALEAvoLLE TV £vToon
TOL.
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5.6 IIpooON KN €£vOG €€ arhayr) TAAVOV

‘Eva e9é alhayng mAdvov ( transitions kivor pia odhoyn and oknvi oty emouevn 1| amod
éva mAavo o€ éva dAALo. To amlobotepo @€ aAloyng TAdvov gival To

Yoot koypo (cut), Baoel tov omoiov TO TEAELTAIO KOPE TOV €VOG MAGVOL 00Myel
anevBeiag oto TPMOTO KOPE TOL AAAOV. TomoBeTdVTOG TAL OVO TPMOTO TAAVA TO EVaL SITAN
oto dAho, dnuovpynioaue éva cut pueta&d tovg .To Edius Smepilopfaver tave oamd 75
gQ& alAayng mAavov, ta omoio, propovue vo emAéEovue and v modéta transitionsIo
va pag fonbnoet va emdéEovpe to kKotdAnio gpé, to Edius Sepupavilet éva gixovidio pe
kivnon ko poe weprypagn yoo Kabe epé. EmmAéov, pmopodue va eEetdoovue og
TPOETIGKOTNON EVaL €PE OAAAYTG TAAVOL LE TPAYLATIKE KOPE TOV TAAVOV LLOG.

[a va mpocBécovpe evivmwolokd €01KE €pé PeETOEL TOV OKNVAOV, To. omoio Oa
TPOGEAKDOLV TNV TPOCOYN TOV BEAT®V, HTOPOVLE VO, XPNCUYLOTOGOVLLE TO EIOIKE

eQ& aAlaync TAdvov mov dwabétel to Edius 5 omwg :

Sidivon (Dissolve), ckovmiopa (Wipe) kot {oop (Zoom). Emdéyovtag oto mapdbupo
TV £0¢ transitionsgiaAéyovpe v petdfoon cross dissolveo cépvoupe

o1o onueio cutmov siyape avipecsa ota SLVO TAAVO .

To ep¢ awtd dTMS Kot OTOLONTOTE ALY TPOKOAOVLE EITE TNV EIKOVA EITE GTOV M)XO
LLOG, Y10 VO LTOPOVULE VoL TTOVUE OTL Vo, pLog foAevel 1 6Tt pog tkavomotohv Ba Tpémet va ta
eréyEovpe kot va ta dodpe. Me v petakivion g YPOUUNG HOVTAL UTOPOVUE Vo
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e€etdoovpe ota ypnyopo €va €QE OAAAYNG TAAVOL OAAG M TPOEMICKOTNON QLT OEV
amoOnkedeTaL, OTOTE dEV UTOPOVUE VO TNV TpofdAovpe

Eava. Ymapyovv 000 TPOmOL €AEYXOL TV GAAUYDV HOG, EVOS YPNYOPOS HE KOAA
OTOTEAEGLLOTO TPOEMICKONNONG OAAG Oyl TO TEAMKE KOl £VOG o0 apyOG O 0TO10g OUMG
pog oivel Pivteo-gikdva o€ TEAKN LOPOT).

TomoBetovpe ToV deiktn atov ydpaka ypdvov Tov Topabdvpov Timeline Gy mepoyn e
T €€ aALAYNG TAGVOL) Kol KpaTdpe Totnpévo to TAnktpo Alt

(Windows) ; Options (Macintosh) O deiktng petatpénetor oe éva pukpd PELOG TOL
delyvel mpog Ta KAT®. XVpovpe Tov OeikTn oTOV YApako ypodvov, TOVE® amd TO €QE
aAAayNG TAGvoV, Kpatadvtag matnuévo to TAnktpo Alt 1 Option. To cvpoipo Katd avtd
oV TpOTO [oG Topdoyel o ypryopn nEBodo ywo va PAEmOVLUE GE TPOEMIGKONNON TO
Bivteo pog, oAl dev pmopel va pog 0dcel e akpifeto v

TOYVTNTO TOV KOPE, OEGOUEVOL OTL UETAKIVOOUE TOV OgikTn He TO YEPL, TapOAX QVTA
popoVE Vo doVUE TV HETAPaoN Kot EpOGOV pag tkavorotel motaue Enterkot ovtopata
t0 Tpoypappa dnuovpyel Preview filespetd omoia amoOnkedel v petdfoon avtiy.
AoV yivel autd pmopovpe pe akpifela va dovpe ) petdfoon.

H emloym tov 1pdmov aAloyng mAavav kot edm eivan kaBapd BEpa Tpotipnong Kot oty
TAgoyYneio Tovg 00 eMAEYOLUE LETAPAONG LE KOWYILO KOl

cross dissolve.

H umépo g mepoyne epyociog (work area barkaBopilelt to tunqua tov épyov mov
Béhovpe va gppavicovpe o€ mpoemiokoOmnon (1e ta €9 oAroyfg TAAVOL

Kot 0AAG €0€), 1 va eEdyovpe og Tovia . H urdpo avth epgavifetal 61o endve pépog e
Timeline, ue éva kitpvo ypdpa Yo TN TEPLOYN TNV omoia BEAovUE VoL

dovAgvovpe. Mmopobue avtr T umdpo eite va v piKkpoivovpe eite vo v
LEYOADGOLE GTNV O1APKELDL TNG.

Metd to T€A0G TG S10d1Kaciog aVTNG ETAEYOVLE

File > Save as %vopa apysiov mov BéAovpe

ko Enter, pe tov tpdémo avtd vmodnkevoope oTdONTOTE OALAYEG KAVOLE GTNV £PYOCia
pog. Avti n epyacio TpENEL vaL YIVETOL OPKETA GLUYVE KOTA TNV OBPKELL TNG
eneEepyasiog yo va gipaote olyovpor 6t dev Ba yobel pépog ™ dovAeldg mov Kavaype,
Hio Kot TO YVOoTO KOAANUA TopoLGLALETOL GTOVG NAEKTPOVIKOVS VITOAOYLIGTEG Eivail TOAD
mBovo va cuuPet, 101k av enelepyaloOpaote peyaia Kot

ocvvleta £pya.

5.7 Hrayvtnta evog mhavov

[MoAAég popéc cuveyilovTag TV epyacio SomoT®VOLHE OTL KATO 0O TOL TAGVOL TTOV
xpnoyomolovpe to BEAovE Yoo TEPLGGOTEPO YPOHVO amd OTL GTNV TPAYHOTIKOTN T Eival
Kot oVt dgv yivetan pe emthoyn in & out yio peyadvtepn

ougpKel AOY® pUN OPKETOL VAIKOV, KOpE ONANON 1 OKOUO Kol TNV €AATIOON 1TNG
ToOTNTOC Hag okNvNg Omwg cvpfaiver pe v emavainyn ( w.y. evog YKol og Evav
TOS0GPUPIKO OydVa Kot TV TPOBOAr] TG GAoNE 6€ apyn TayLTNTA ) GTNV TEPITTOON
OLTY] WTOPOVUE VO OAAGEOVLLE TN TOYVTNTO OVOTOLPOYMYNG TOL TAAVOL Y10l VO KAVOULLLE VoL

43



npoPdrete ypnyopdtepa 1 apyodtepa. H ooy g taydmmrag arralel T SidpKeL TOL
TAGVOL Y®pPic va TpocsBitel N va avarpel kKapé . H taydnra evog mAdvou

etvar m TodTTAL avomapay®YNG TG Opdiong 1 TOL NYOL, G GUYKPLON UE TV ToHTNTA
eyypaons. H dudpketa vog mhdvou gtvat 1o 1ocd Tov ¥pdvov mov ypetdleTon

v va TpoPAnBet n ypovikn dtopopd petatd Tov onueiov Apyng kot Télovg Tov mAGvov.
"Eto1 pmopovpe vo peyaAdcovpe TV Stdpkeld EVOG TAAVOL UIKPOIVOVTOG TNV

TaxOTNTO TOV.

[No vo oAlaéovpe omtikd v toxdTNTA, pmopovpe vo emMAELEOLUE TO epyaieio
avéopeimong Toydrog ( Rate Stretch kou va cvpovpe gite 10 apiotepd gite 10 6610
dxpo tov TAGvov. To epyoreio avéopelidoelg toydTNTOS Ppioketor GTNV  YPOUUN
gpyolreiov Tov mapadvpov Timeline. Mropodie exiong vo ELOTTOGOVE 7 AKOUN KoL VO,
OVTIGTPEYOLLE TNV KivoT OV LILAPYEL LEGO GE EVOL TAGVO KAVOVTAG TIG £E1G EMAOYES !

AoV popkapovpe to TAGvVo Tov omoiov Bélovpe va aAAdEovE TV TAXHTNTA KO EVOD
BplokoOUaoTE ETAVED GE AVTO LE TO TOVTIKL TATAUE TO 0e&l TANKTPO TOL TOVTIKION LOG KOt
anmd TV €mA0y Speedemiieyovpe Kot v tayvtnta mov Béhovpe ‘Etotl oryd oyd kot
CLULPOVA UE TO TPOYPOUUO e TO Oolo gimape oty apyn 0Tt B dovAéyovpe, ytilovue
oyd oyd v epyacio .Ztnv ddpkeln g pong mopeUPArovtonl Kol KOTow LEPN LG
ovvévtevéng n omoio tomobeteiton pe Tov 1610 TpdmO IN & Out. Etnv mepintmon mov
YPEWOTEL VO

KOéyovpe kbmow optAa 1 epaon M AéEn amd v cuvévtevén, ywo va Pyaivel To vonua
nov BéLovpe gite emedn 0 GVVEVTELELNLOUEVOS OTAMG UTEPSEVTNKE GTO AOY® TOV,
YPNOUOTOI0VE CUt TO omoio OpmG givor ousbntd doynuo otn pon g Toviog. XTnv
TEPIMTMOT AT XPNCHOTOLOVUE KATola TPIK LAV 0 Adyog dtaxkomteTon omd Eva 1 dvo cut
Kot To omoio umopovue vo ofnoovpe yuo pod 1 €va dEVLTEPO TNV EIKOVO KOl VO
ovveyioovpe PETA KOVOVIKAL.

Av16 Ba Kdvovpe 6TO £pY0 VTO LE SVLO TPOTOVG .

1. Xpnowomotovpe v petdfaocn cross dissolvesav podpo Bivieo yio piod devtepo
ovveyilovpe v endpevn ekdva Kovovikd . Me tov 1poémo awtd Exovpe €va otiypiaio
ofnoipo g ekdvog Kot 1o TEMKS amotédeopa va gtvot

o TIKA KOO .

2. IPnoo g ewkovag pe tnv ypnomn tov display opacity rubber bands .

5.8 H ypnion tov black videokm tov ep¢ oto Edius 5

XpNoipomolovpe 1o povpo Pivteo 10c0 yio TNV aAlayn Keeaiaiowv oto £pyo, 6GO Kot yio
10 MOy® Tov gimape Tponyovpévmd. Elvar apketd xproylo Kot 6

onowdmote GAAN gpoppoyn motevovpe 0Tt Topralel ( Tithovg téhovg , apyn g
TOWiog, TGN 68 HODPO LE LOVOIKT 00 KAT® KTA.) .

INo va éxovpe pavpo Bivteo kavoope : File > Newkot and tig emioyéc dwodéyovpe Black

video. Mg tov tpdémo avtd €xovpe otn 61dbeon pog pavpo Pivteo, To omoio eppaviletan
oto mapabvpo £pyov Projectoav to aAld Pivteo mov €yovpe. H
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yponon and v GAAn tov Display opacity rubbers banghnoiuevet yio 10 otadioxd
offopo pog eikdvog N 1o otadtako Eexivnuo mg. [ToAd yprioyo oy Evapén evog
Bépatog e oTadKY ELPAVICEL TNG EIKOVAG. XPNCILOTO00NE TO Hadpo Bivieo 1060 Yo
™V oAAayn Kepaiaimv oto €pyo,

600 Kol Yo 10 AOy® mov eimape mponyovuévec. Eivor apketd yprioyo kot og
onowdmote GAAN gpappoyn motedovpe 6Tt Toupralet ( TitAovg TéAOLS , apyf TG
Toviag, Tavon o€ Hadpo UE LOVGIKY amd KOT® KTA.) .

I va égovpe pavpo PBivteo kavoope : File > Newkot and tic emhoyéc dtodéyovpe Black
video. Mg tov tpdémo avtd €xovpe otn 61dbeon pog pavpo Pivteo, To omoio eppaviletan
oto mapabvpo £pyov Projectoav to aAld Bivteo mov €yovpe. H

ypnon and v GAAn tov Display opacity rubbers bangpnoiuevet yia 10 otadioxd
ofnoto pag ewovag 1 1o otadtako Eekivnua . [oAd ypriowo oty Evapén evog
Bépatog pe otadiokn epeavicet e ewdvoc. H dwadikasio avt pmopel va yiver pdévo oe
Kamoo and ta Pondntikd Pivteo track mov vmdpyovv. ‘Etol ool petaxivicovpe to
TAGvo ov BEAovUE Vo ELEAVICTEL e TASOKS TPOTO

Me v potn 100 KEPGOPA TOV OANG TNV AKOVUTGOVE YIVETOL YEPAKL GOPOVUE TPOG TOL
Kbto amd Vv pepld mov Béhovpe. Av Op®G KATA TN OEPKELD HOG GLUVEVTELENG TTOL
ovvnbiletar va avaeépetar g CUE vdpyovv 1660 TOAAG CUt Kot 1) TOPOTAV® TEYXVIKT
elvar advvarn, TTE PITOPOLUE VO

OVTIKOTOGTICOVE T onueio eketva TG €kOvag pe KAmolo AL, cuvOmG cuvaen UE
aVTE OV AVAPEPEL O AOYOG TNG GLVEVTELENGS. ALt N TEYVIKT PePaia yiveTon Kot yio vo
dMCOVUE EUPAOT) OTO AOY® JElYVOVTAG KOl GE KOV, 0LTA TOV aKOVpE. Ot EIKOVEG AVTEG
1N ta Bivteo avtd tomobetovvtan o vEPOeon dnAad1| oto Pivteo track

2, ue o PePaia TOAD Yo pMAOTEPO N AKOUN KOL ATDV .

Mmnopo¥pe va tpocBEcovpe 0moladNToTE EPE € £VaL TAAVO 0vE TOGH oTUYUn AV gV LG
apéoeL, amAd TO avalpovpe. Mmopolue ETioNG VO EQAPUOGOVLLE TO 1010

€€, MOALEG POPEG, 6TO 1010 TAGVO pe drapopeTikés 1010tNTeS. [ Tapddetypo pmopovpe
va TpocBEcovpe TOAAG €10 MYNTIKAOV EQE, Y10 TEPUMTMGELS TOV YPELALETAL VO dEGOVUE
poall moAlég evotnteg, e€lOMVOVTOG TIG .XTNV GLYKEKPIUEVN epyacio epapudlovue éva
€QE KoL pdAota otn

peyaAvtepn ddpkeln Tov. AQov emALEOVUE TO €0E amd TNV TOAETO TOV Ppiokoviol Ta
transitionsuali pe to audiokat to video,péca oto omoio Bpickovial Ta £PE TOL

Edius 5. Apov 1o tomofemoovue oto mAdvo mov Béhovue moataue Enter yua va
epappootel kot va to dovue. H opaia petdfaocn o avtd yiveton pe ) xpnon tov

cross dissolveBeBaio Oa pmopovcape vo, KAVOLUE UL TO10 EKTEV] XPNON TOV EQE GTA
TAova oG, oA Kol €00 A0y kaBopd mpotipunong dev Ba o Kavoupe, Taporo

TOV Elval aPKETE TOAD EVTVTOGLUKAL.

Ortav gpappolovue éva gpé o éva TAGvo, 10 €@é @aivetal otnv toiéto Effect Controls.
To g@é givan emiong opatd axpPmg KaT® amd v ypapuun tov Key frame

Tov TTAGVOL. AV €va TAGvO €xel mOAAG @€, TO pevOL POP-UP tor deiyvel Kor eivon
QMOTOCKIOGUEVO OO TAV® TPOG T KAT®. Mropovue va EavalnoeTe Ta €€ amd avTHVY N
Mota yio va 0AAAEOVE OGO EQE EIVAL POTOGKIOGUEVE TPATA .

Me 10 mépog ™S €l0y®YNG Ko puOUIoNG Tov €€, TPENEL Vo Yivel o olpmon Tov
TAGvoL omd TOo Tmpdypapua, ®ote vo  ewooybovv  or  petaforég mov  Eyxovue
TPOLYLOTOTOINGN Kol GOPMG Yo VoL LTopel va avolyet ko va dtaxelpiletal avtd T
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mAdvo. H dadikacio avtn exteleiton pe to mAnktpo Enter.EppaviCeton éva mapdbupo,
T0 OMO{0 HOG EVNUEPDOVEL Yo TO XpOvo mov vmoAeimeton. TéAo¢ amoBnkevovpe v
gpyacio pag e ™ yvoot dtdikacia :

File > Save as %vopo apysiov

Me v yp1ion 66®V EYOVLE TEL LEYPL TOPO KOl OKOAOVODVTOG TO TPOYPOLLLLL TTOV EYOVLE
oo TV apyN, TPOYWPALE GTO GTASIAKO XTIGLLO TOL £PYOV LG, UNV

KAVOVTOG TImoTo GAAO Ol “ KOWYHO, pAYILO, TOTOBETNON '. AV TOPO TO OMOTEAEGLLA LLOG
wavomotet ovtd e&aptaton and epdc. Befaio o tehkog kpitng eivat o Beatrg mov

B det 10 £pyo kot Giyovpa TO KOAAKELTIKA AOYla Tov Bo emmBovv amd avtdv, Ba elvan
Kot 1 avtapolB Tov dnpovpyod. Ortmg Exovpe oM et Eva €pyo cav to PBivieo

pog pmopel va mepi€xet Lovo Pivteo ewcova, omoOTE Kot 1 SOVAEL HOG UTOPEL VO TEAEUDGEL
€00). TN CLYKEKPYEVT] OGS ETAEYOVE VO DITAPYEL YOG, LE TNV LOPOT|

1660 oG aprynong mov o vwhpyel Kot NYoS, 660 Kot amd NG HOLGIKNG Tov O
axovyeTal ot dtdpkela TG pong Tov £pyov. H epyacio mhveo otov Mo piog tawviog ivor
UITOPOVLE VO TOVLLE TTOL0 OITOLTNTIKY OO TV OOVAELL TOL KAVOLLE TPOTYOVUEVMG.

5.9 Titlor

Me v 0AOKANP®OT KOL TOU KOUUATIOL OVTOV KOl &vay EAEYYXO Yo va. doVUE €AV
Toplalel Ko TEAKA oG 1KOVOTolel TO amoTELEGHO GE €KOVO Kot X0 poll Tpoywpdipe
TNV VAOTOINGN HOG GAANG TOPAUETPOL TOV TITA®V TOL £pyov pog . Tawvia yopig TitAovg
dev voeitan . Xperdletat £0Tm €vag TITAOG 6TV apyn Vo ONAMVEL TO OVOLLOL TNG TOVIiOG Kot
€vag 6To TEAOG OV VAL OVOPEPEL ATTAMG, TN AEEN TéN0G. TitAovg pmopovpe va OTIAEOVLE
ToAD gOkola gite pe 1o title designer;to gpyokeio tov Edius Seite pe xdmolo Gidlo
npdypappa 6mwg to Photoshopro lllustratorn axéun kot to Word.

Enedr] 1o title designersivar mold oxvpd epyodeio, n mpoeovig Adon eivar va
YPNOOTO GOV UE aVTO Kat va. Egxdoovue OAa To aAAd, aAld 1 oxéon ™ Adore

LE TIG EAAMNVIKES YPOAUUOTOCELPEG Elval Ko TPOPANUATIKY.

o vo dnpovpyHoovpe oG TITAOVG TPEmEl and®d¢ Vo KoAéoovpe v evioin Title >
New Title. Auéowg avoiyst to moapdbvpo, to omoio pumopovpe vo Bewpricovue ®g éva
TPOYPOUUO HEGO OTO TPOYPOUULO. 2T aplotepd PAETOVLE Ta epyaleior TOV EYOLUE OTN
duabeon pog Kot ot PéEoT Tov Kapé pog. Me 1o TpodypoppLo

OVTO UTOPOVUE VO QTIAEOVUE €1TE OKIVITOVG €iTE KIVOLUEVOLS TiTAOVG 0T0 HEyeBog To
YPOUO Kot Lopen Tov emtbupovpe. Ady® kot TIAL TPOGMTIKNG TPOTiunong o

etid&ovpe Tithovg ot omoiot Ba eppavifovral Yo Kamowa devTépa Kot ot cvveyeion Ha
eCapavifovtat. Me 10 de&l Kk emdeyovpe To péyebog Kot To GTLA

YPOUUOTOGEPAS KOl 6T cuveyeia ypapodpe Tovg TitAovg pag. To mapddo&o pe tov Title
gtvai 0TL dev drabéter pevov File ya to avorypo 1 v amobnkevon tov tithmv

oV QTIYTOOUE. L0100 o1l Tithol amobnkedovrol oe Eeywplotd apyeia, mov Exouvv
katon&et pril. Epeig amAdg (ntdpe amd 10 mpdypoppa vo KAEIGEL, Yo va oG

pPOTNCEL OV ETOVUOVILE VO GOGOVE TOVS TITAOLS 1} OYL.

"o va mpocBécovue tov TitAo M| TOLE TiTAOLE 6TO Project pag, sivar amapaitnTo va
g16GyovE TO apyeio Tovg pe tv PonBeta tng evroing Import ( F3) .
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O tithog Ba eugaviotel og ewovidlo oto mapdBvpo project (épyov ) ko amd Ket
UTTOPOVLE VO, TOV YPNCULOTOCOVIE GE KOTOL0 KAVAAL EIKOVAG TNG XPOVIKNG YPUUUNG,
omwg kot kéBe aAdo TAdvo. Eva axopa tpik mov Ba kévovpe 610

OLYKEKPEVO €PYo givor kot M pon TV TITA®V TEAOLG TOL £pyov pog, pall pe v
oAlotnon ewovov pésa and to vadpyov Pivteo. Avtd Ba yiver pe v avébeon

KIVomg TV EIKOVOV.

Cur ET0:O100  Key ERDI00ITS 1008

Cast of Characters

Armadillo Tom Banks
Indi Sconce Morison Ford
Amalia Gita Jones
Old Man - : Nicolas Sage —F——
Miss Wobble Meg Brian
Young Solder Silvestro Balon
His Sister Juliette Brioche
Girl in Cafe Faye Faraway
Gangster Clint Westwood
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5.10IIepifariov o10pO®ONG YPORATOS EPYULELN YPOUATOTOLOD

To mepiparrov d16pOwong ypoduatoc tov Edius 5 dwapopomoteitor to. vorlowra £Totpo
nepipdAiovta 6to Ot avoiyovv €€ opiopod dvo mapdbupa ‘povitop’ ko 6t0 OTL TO
apabvpo ‘Project’ epeaviCeton n koptéia ‘Effect’, avri g

OPYIKNG LE TOL TAGVE, TTOV aapTiLOVV TO WVIOKN HOG .

To éva amd Ta dvo mapdBvpa povitop, 1o deéi, TeprhapPdvel To LMKO paG , eV 6T0 GAAO
10 aplotepd, emieyovue epeig T Bo amewoviCeton . Ta @iltpo mov mpodkertal va
YPNOCLULOTOGOVE Y10 TO ETOAOVAL BpiokovTan

ot opddeg Video Effects / Adjustkar Video Effect / Image Control T'o vo
EQOPUOGOLLE GOV EVa TAGVO KATOL0 OO OVTA OV €YOVUE TOPE VoL TO GUPOVLUE UE TO
TovtiKt 610 mapdbupo ypovikng ypauung ( Timeline ),kat va to pi&ovpe ndvm 6to TAGVO
oG,

Amo T oTiyu] OV €YOVUE €QPAPUOCEL KATOLO QiATpo o €va TAAVO, GTO TAPABvLPO
Timeline gpgaviletar po koKKvn ypappun Tave arnd ovtd. Me tov tpoémo avtd to Edius
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5 pog Aéel 0T To TAGVO €YEL VITOOTEL KATOL0 TPOTOTOINGT OAAG 1) TEAIKN EIKOVA OV EXEL
akOpo Kataokevaotel, oNAady dev €xel @ivol axoun to Aeyduevo ‘rendering’ (n
‘amodoon’ ).To renderingeivar pdArov ypovoPopa dadikacio, adrd to Edius 5 pag
amaAAdcoEL PEXPL TV TEAevTain oTiyun] amd Tov puneAd. Expetailevopevo v taydtnta
TOV GNUEPIVOV VTOAOYIGTAOV, LG EMTPENEL KAVOLUE U0 TPOCEYYIGTIKY TPOEMIOKOTNON
TOV OMOTEAECUOTOS MOG, TPOKEUEVOL VO OTOPAGIGOVHE oV ol pvOuicelg pog sivor
ocwotéc. Omowadnmote oTiypn], ®CTOGO, OMOLOGONTOTE TPV KOTUCKEVOOTEL 1 TEMKY|
ekd0YN TNG TOVIiNG oG,

umopovpe vo {ntnoovpe va yiver to rendering gepokivnto ‘ , KOADVIOG TNV €VIOAN
Sequence / Render Work Argaotdvrag amdd Enter.ITiavd ota onoia to
renderingéyet 6N yivel onpeldvVoOvVTOL e o TPAGIVY YPOUUT. AVTd mov dgv €xouv
VIOoTEL aALOimOoN PEVOLVY Ympic Kamoto g0 ypdpa. Exoviag miéov piet kdmoto
eiAtpo oe évo TAGVO Ogv €yovpe mapd vo TAUE otV TPITN KAPTEAX TOV TOPadHpov
Project, Effect ControlsEktog amd ta dvo mpoemieypéva and to Edius 5oeiktpa |,
Motion ka1 Opacity, kabeti dAlo mov eppaviletor 6NV Kaptéda ovt gival ta eiltpa
7oV £yovpe emAEEEL epeic Kot Ta dtabéotpa puOeTIKG TOLC.

Yotépa and avtd ta yevikd, ag nepdoovpe oty ovoia. Ta epyolieio mov pog Tpooeépet
10 Edius 5yt v 810pfwon kot v enépPacn ota ypduata TS EIKOVIS Hog Bpiokovtan
ovykekpipéva oty opdda Image Controlsgktog and ta Brightness & Contrast, Channel
Mixer, Levelskor Procampmov Bpickovtot, poli

e kémola axdun, oty opdda Adjust.

Am\G epyaieia

Brightness & Contrast:

To amhoVoTEPO KOl MO EVPEWMS YPNCYLOTOLOVUEVO GIATPO TOVOTIKNG O10pBmong Kavel
aVTO TOL AEEL TO OVOL TOV, PLOUILEL TN POTEVOTNTO KO TO KOVTPAGT TNG EIKOVOS LLOG.

Gamma Correction:

To epyareio emAoYNg Yo TNV TPOTOTOINGT TG POTEWVOTNTAG TNG £KOVAG HaG.Onwg Oa
doUE Kol OTN GuveEXEln OTIG TEPLOCOTEPES TOV TEPITTMOGEMY KAVEL KOADTEPT OOVAELN
and to Brightness & Contrast .

Color Balance (HALkot RIB):

PvBuiler v tovikn| tooppomion TG €KOVAG MG, €1t KOTE omdyYpwon, KOPEGUO Ko
Aoumpotnto (Hue, Saturatiornkar Luminance)eite katd kOKKivn, Tpaovn Kot PmAe
oLVIGTOON TOL EyYpOdHOL ofjuotog pog (Red, Greemon Blue).

Levels:
Epyaieio pe 1o omoio pmopodpe vo dtopfdcovpe ta eXinedo POTEWVITNTOS TNG EKOVOG

nag, gite o O o T KavaAlo Tovtoypova gite o€ Kabéva amd povo tov. Mali
ue to Gamma Correctiosivol to epyaigio ETAOYNG Yot TETOOV €100G Epyacia .
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Preamp:

To Preampmpocopoidvet ta xepiotipla S10pHwong T0Vov Kot YPOUATOG TOV GUVOVTAULE
pe cupPatikés TNAEOPAGELG Kot Pivteo .

Ioyvpd epyorsio

Color Corrector:

H ‘vavoapyida’ ypopatikig kot tovikng iopbmaong tov Edius SAnotelel, otnv ovoia, pio
OLALOYN EPYOALEI®V TOVL KAVEL T TAVTOL.

Channel Mixer:

Avoperyvoet ové 6vo ta kavailo cuvictooov R, Gkol B dnpovpydvrog
EVOLOPEPOVTA KoL TTOAD YPNCLUO ATOTEAEGLOTA.

AnNovpyikd epyorgio.

Black & White:
Mertatpénet Eva Eyypopo TAGVO Ge aoTPOUAVPO.

Tint:
Xpopotilel To TAGVO HOG LE TO YPOUO 1] TV amOYP®OT oL Bo eMAEEOVLE.
Color Match:

Me 10 @iATpO aWTO PTOPOVUE VAL PEPOVUE ‘KOVTE' amd YPOUOTIKAG KOl TOVIKNG TAELPAS
Vo Eeymplotd TAOVA.

Color Pass:

Metatpénetl v €IKOVA LOG GE ACTPOUOLPT KOL ETLTPETEL VO ‘TEPACEL HOVO
TO YPOUO TOV £YOVUE EMAEEEL KO TAL GVYYEVIKA TOV.

Color Replace:

Mog emtpénel va emAéEovpe €va YPOUO KOl VO TO OVTIKATOGTCGOVUE, UE AlYOTEPN M
TEPLOGOTEPT aKpiPetla, pe Kdmolo GAro.

Color Offset:
[Tpoxoiel nBeAnuévn TOpapdOpE®OT GTNV EKOVE HOG, YOADVTAG TN GUYKAOYN TV

YPOUATOV LG, ONUIOVPYADVTAS VA EQE OTMG ALTO TOL PAETOVUE KA POPA OE
TEPLOOKA, OTAV TOL LEAOVLIA OEV £YOVV TEGEL CMOOTA TO VAl TAV® GTO GAAO.

49



AvaOeon kivnonc oe TAdvo

Mo emmAéov €pé 1o Edius 5pag emtpénel va mepiotpéyovpe va kavovpe Lovp, va
Béoovpe yevikd o kivnon ototikég eikoveg Emieyodpe Tig eucoveg mov BELovE Ko TIg
tonofetovpe og vEpheon endve and to Pivteo 1 kot apov emAéEovpe o and avTég
oty maAéta Effect controlkdvovpe KAk oto set upota 6e&ié Tov €pé Kivnong ya vo
avoifovpe 1o mapdbvpo daAdyov Motion settings Xty endve apiotepn mEPLOYN TOL
mapadopov  SwAdyov, €va  detypo TOv  emdeyduevov  TAGvov  axkoAovBel v
npoemheypévn dadpoun kivnong (motion path) H néve de&id meproyn mopovoidlel tnv
dradpopn Kivnong pe T Kopé Kot Tol KAELOLE IOV DTOJOEIKVOOVY TNV apyN Kol TO TEAOG TNG
. "o Vv kataxdpven kivnon mov BELOLLE VO TETOYOVIE , GVPOVLE Ta KOPE KAEW1G Start
& Finish dote va dodue ) kivnon mov Bélovue. Emdéyovue emiong va yivetar KGmolo
oTad1oko ovp oty ewova pag Kabdg oAoBaivel Ko PAETOVLE TNV TPOEMGKOTNON TNG -
Epdoov tedeimdoove ko pog tkavomolel To amoTtéAeca amodnkedovLE TO £pyo pag . X
GULVEYELD KAVOVUE TO 1010 Kol OTIG VITOAOITESG EIKOVES . AP0 KAVOLUE Evav aKOUN TEAKO
ELEYYO TOV £PYOV TPOYWPAUE GTO TEAIKO GTAOLO..
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KE®AAAIO 6

6.1 Iow givol Ta amoteréopata

Ta amoteléopata TG CLYKEKPUEVNG TTVYLOKNG To PAEmOVE Aueca epOGoV To Pivieo
£xel oOAoKANPpwOel kKot To PAETOLE OO TNV apyn MG TO TEAOVUEVA OO TO ATOTEAEGLLOLTOL
mov Ba dovpe glvan ta Pivieo epdoov Eyovv emelepyaotel amd epds Pdon akyopiBumv g
EPAPLOYNG OV YPNCLULOTOMCAUE KAODS KO TIG AAAUYEG GE SLAPOPO. EMUTEIX TOL APOPQL
éva Pivteo onwg eivar n TtovTnTor B6pLPOG, TO YPOUATE KOl 1) GOCTH KOTOVOUN TNG
eotewvomroag Exoviag wdver 6Ao avtd €yovpe MO TAPEL Mo YELON YL TO TAG
Aertovpyet n ynowokn enelepyacio Pivieo mov givor QUeEso cLVOEUEVT Kol HE GANEG
TOAVQACIKES EPAPUOYEG EVOG LEYAAOVL KAGOOL TNG TANpoPopikns. Oco apdpa tdpa 1O
OTTIKO OMOTEAEGLO. GOV GUVOAO £XOVUE ol appoviky] akoAovBio tov Bivieo oty onoia
0 Beatng KaBeTon Ko TapakoAovBel ywpic va PapiéTat.

6.2 T kol mowov 0o @@PEMGEL | ATVYLOKT] CVTN

Oco agopa Tov omovdootn 1 wTVYWK) oVt o Tov oeelnoel v oe €va TOAD
LOVTEPVO TOUEN TOAVUEG®V TOV apopa TV Yynoewokn eneéepyacio Pivteo. Aoviedovtag
Thve o€ eQapproYEg emeEepyaciag Pivteo yivetar OA0 kot o owkelo to va emeepydletan
ewoveg Pivteo potoypapieg va omdkto eumelpieg mhve oto moAvpéca. Emiomg
YPNOUOTOLEL GLVOVOUGHO TOAADY EQPOPUOYDV GTO VO EMTOYEL VO KOAO OTOTEAECUAL.
Mmnopel va ypnolponomast epappoyn enetepyosioc Pivieo potoypapiog n xon OGTE va
ethoetl og €va emBLUNTd 6TdHY0 0 OTOL0G Oev Ba JPEPEL TOAD OO EVOL EMOAYYEALATIKO
amotéAecpa. Mnv Eeyvape GAADGTE OTL 0 GTOYOG TNG EKTOUOEVONG KOL TNG TTUYIOKNG HOLG
elvar va gtdoovpe og éva TéTo10 €MIMEd0 MOTE VO, UTOPOVUE vo. Pyovue otnv ayopd
epyociog.

Ooco apdpa tdpa tov Beatn mov Ba mapakorovdnoet Tov eicdyst apudvika o€ £va KOGHO
omolog Oev elval kol TOAD YVOGTOG OTO EAANVIKO KOWO Kol TOv mopabEtel o
TPUYHOTIKOTNTO EVOAAOKTIKY] omd TNV Ok Kabdg Kol Tnv yvoplic tov pE TO
CLYKPIUEVO  emAyyeApa. Mnv  Eexyvhpe OTL dovAeion eAANVIKNG mopdywyng o€
enayyeAMLOTIKO eminedo pe avtd 1o BEpa dev €xel vapiel péxpt otiyuns. Aveta OToTE
UTOPOVLE VO YPTOLUOTOUCOVUE TNV AEEN <«TTPOTOTLTIO» GTNV TMTLYLOKY OaV KATL
Kovovpylo

6.3 TiypnopnéTnTe 6KOTOVS KOl 6TOYOVS £XEL

[Mpotopyikdg 6td)0g TV TOALUECOV KOl TG ynoakng emegepyaciog Pivieo eivan m
onuovpyia epappoydv mov Bo elvar amAéc otov xpnoTiky Hapén evOg AmAOIKOV, oTN
xpnomn, moivpeowkov interface av&dvel v omOTELEGUOTIKOTNTO TOL YPNOTH KoL TNV
ToyVTNTO eKUAONONG TOL AOYIOHIKOD TEMKOG YPNOTNG WTOPEl GYETIKA Ypryopa vo
e€apnOel and T1g 0dNYieg XPNOELS TOV AOYIGUIKOV.

H edypnot kot dwcntiky dwomddn ypnot) mailer emiong peydho poéro. To interface
evOg TPOYPAUUATOG dEV apKEL POV va TEPLEYEL EIKOVES, NYOVS, KOVUTLA TAOYyNong n
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OAAG EVOAAOKTIKA UEYOAOTPETE VO vl E0YPNGTO KOl VO OVTIOTOLEL O YVMOGELS TOL
oM katéyel 0 TeMKOG ypNoms. Ot TEPIGGOTEPEG EPAPLOYEG TOAVUEC®Y aKOAOVOOL
KOVOVEG EVYPNOTIOG AOYIGHIKOD Kol TEPVOVV GYETIKA TECT, TPV APYICEL 1] EUTOPIKT TOVG
eKUETOAAEVGON. Me auTOV TPOTO Ol EPAPUOYES EIVAL EVKOAEG GTNV XP1OT TOVS KOl GTNV
eKpAON o™ TOVG KO 1) Tod0YT TOVG GUEDT).

6.4 Ilpocappoyi otig avaykKes TOL XPNGTNH

Ot epappoyés molvpéowv kot ilaitepa ™G ynowkng emneCepyaciog Pivieo, €xovv
wavotTo va Tpocapuolovior ot avaykeg Tov ypnotav. H mpocsapupoyn €ykeitoan 1o
yeYovdg OTL Ol OVOyVMOOTEG UTOPOVV VO YPNCLUOTOCOVY OTav 0vTol emBupovy e To
oo touvg pvOBud. H dvvatdto PEAETNG KOl TOAAOTAGV ETOVOANYEDV TOV 1010V
fepdtov Kot 01 EVOAAOKTIKOL TPOTOL TOPOVGINGNG TOV TANPOPOPLDYV, KOOIGTOUV TO
AOYIOHIKO TOAVUECOV (G VAL TPOCAPUOGILO dAGKOAO-GOUBOVAO.

[dwitepa ta moAvpécsa pe vymAd Babud aAANAETIOPOONG TPOSPEPOLY TV duvATOTITA
TPOCAPUOYNS AKOUN KOt TOV 10100 AOYIGUIKOV ,KaOdDG Kot TNV dnpovpyia vEwv cevapiov
TAOTYNONG KOl LOVOTOTIAOV OVOKAALYNG TNG YVDONG.

6.5 KoAdTtepn KaTavOG1) TOL TEPLEYONEVOV

H Ymop&n moAhamhdv HopedV avamapdoTacns e 010G TANPoeopiag EMITPENEL GTOV
EKTOOEVOUEVO TNV KOAVTEPY KOTOVONON TV Topovolalopévav dedopévav. H
TAVTOYPOVT] TOPOLGIOCT] KEWEVOL KOVDV, Nxov Kot Bivieo €xel ¢ amoTéEAESHO TNV
d¥yepon moAAdV avBpomivov owcBiosov 0000 To epebBiocpata mov déxeton o
EKTOOEVOUEVOG etvat TOAAOTTAG. Me TV amo@uyn g povotoviag mov gpeaviletot otov
VIAPYEL HOVO 0L HOPON TOPOVGINONS TOV TANPOPOPLOV, dlatnpeitol apeiwto To
EVOLOPEPOV OO TOLG OVUYVMOTES TNG EPAUPHOYNS KOl TEAMKE OmoppopiToL TEPICCOTEPT
YVOON.

6.6 Meimon k06T0VG

Av kol opywd m ypion TV TOAVHECHOV epeoaviletor ®¢ poe akpin Abomn TeAKd
ovpPaiver to avrtiBero. H moapdymyn ekradevtikdv moilvpacikedv CD anotpémer v
EKTOTMOOY] TOV TANPOPOPIOV GE YOPTL EMTPEMOVIOG TNV OLYVI OVOVEDCN TOV
dedopévarv. TIohdég @oOpeg o ddokaiog kol yevikd m avBpomwvn moapéupaon eivon
MEPUTTEVAUE OMOTEAEGHO VO HEWOVOVTOL ToL AETOLPYIKA £E0da. EmmAéov o ypryopog
pLOUOG ATOKTNONG YVOGE®V Kol OeE0TNTMV HECH TNG NAEKTPOVIKNG EPAPLOYNG 0dnyel
o€ MEPULTEP® £EOIKOVOUNOT XPNUATOV Y0 TOV XPNOTH 1 TNV £TOLPIO TOL YPTCLULOTOLEL
TEYVOLOYiEC TOAVUEC MV
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6.7 Awookédaon

O televtaiog AOYog oamd pHOVOG TOL OmOTEAEl €va 1oYLPO TAEOVEKTNUO VEEP TNG
teyvoloyiag mov mpaypatonoleitor to mopdv Pifiio. Ta moivpéoa €xovv ¢ eyyevég
YOPOKTNPOTIKO TNV dokedaon. Ot ePapuloyés OAANAETIOPOCTIKMOV TOAVUECHV
avtipetonifoviol omd pKkpoHs Kot PHeEYAAOVS, nAklakd, xpnoteg g Eva maryviot. Eival
oLy Vidlo avakdALYNG YVOoE®MY Kot Tautdypova yoyaywyioc. Oco mo gdypnoto Kot mo
J1oKeSAOTIKA vt TOGO MO EVKOAN YIVETOL EUTOPIKMG OTOOEKTA.

6.8 Ieproyég ypniong

Ta moAvpéca £xovv 01€160VGEL GXEOOV OAEG TIG KOOMUEPIVEG OPACTNPLOTNTEG LOANKD TIC
OYOMKEG OPACTNPLOTNTEG HOG HEYPL KO TNV OLOVOUY] TOVG HEGM EVTLTov TVUTOVL. ['evikd
UTTOPOVLE VO AVayVOPIGOVE TOVG akOAOVHOVE YEVIKOVS TOUEIS YPNOTG TOV TOAVUECOV.
[Ipota n exmaidevon kol 1 katdption. H ekmaidevon amoteAdel tov mAéov KOTAAANAO
YOPO Yy TNV TEYVOAOYia TV molvuécwv. H exmaidevon ko n a&loldoynomn pEow
AOYIGKOD Omontel TNV XP1ON TOAADV HEGMV MOCTE 1 EPAPHOYN Vo, Elvar gdypnoTn Kot
edkvotikn. [IA0oc exmadevtikdv TITA®V TOAVHECOV KLKAOPOPOVUV GTO EUTOPLO KO
TOAALA amd avtd &rovv ypnuatodotndel omd 1o vmovpyelo €BvikNG modeiog Ko
Opnokevpdtov ko &ovv dwaveundel ota oyxoiewn.H avantuén defomtov péow
NAEKTPOVIKOV HECMV  KATOEG GOPES VTEPTEPEL NG KAUGIKNG  OLOOUCKAALOG,EVD
TEPLGGOTEPEG POPEG TN CLUTANPAVEL TEPLEYOVTOS VEOLS TPOTOVG EKUAONGNG KOl OTTIKES
KO MYMTIKEG AETTOUEPELES TOL OEV UTOPOVV VOl TOPOVGIAGTOVV e AAAO TPOTO.

H epyocio emiong elvar xkdtt mohd onpavtiko.XTov €pyociokd YOpo 1 YpPNon Twv
moAvpEcwV PBpiokel Tapd TOAAEG epapproyes.Mmopetl va ypnoomombel yio KatdpTion
epyalOUEVOV, YL TNV SOPTLOT KOl TOANGT TOV TPOIOVIMV KOl Y10 TV TOPOLGINGT] TOV
etopik®v  dgdopevav.Or  TOAVQOCIKEG — €QOPUOYEG otV gpyacio.  ovvnBmg
YPNOCLLOTOIOVVTOL HECH ECOTEPTKOV SIKTVOV TNG ETOUPELNG 1) TOL SLAOIKTHOV.

H mnpoedpnon sivar évag GAAOG TOPENG TOL OTAGYOAEL TAL TOAVUECH.EXTO TEPINTEPA
exBéocewv tomobetobvtal pnyoviuoto pe 0BOveg aeng,To Omoict EVIUEPMVOLV KOl
KaBodnyovv tov emokENTN, apKel va mEcovy peptkeég popég v 00ovn.Ot epnuepideg
OAAG Ko TOAAEG MAEKTPOVIKES EYKVKAOTOIOEIEG €YOVLV TOAVUECIKN TOPOVGIOGT) GTO
dwdikTvo. Ot ¥pNoteg ToL SOIKTHOL PTOPOVV EVKOAN KOl YPNyopa, aKOAOLODVTOG
ghkvoTikd interfacestov tovg mapéyovtat vo avakaAdyovy Ty embounty TAnpoeopia.
EmumAéov xabnuepwvd, mpoceépovion pe tig epnuepideg ¢d ko dvd pe Bépoto g
EMKALPOTNTOG KO IGTOPIKE 1] OAAG OTUAVTIKE YEYOVOTOL

Téhog n duokédaot, To vEX NAEKTPOVIKE oy vidlo S1KTvakd 1 avtdvoua aElomolovy TV
10Y0 TOV TOALOTA®V PECOV €161 MOTE va gival TpotdTLIo Kot EAKLoTiKd. [lepiéyovv
aroondvta Bivieo, Kivovpeva oyédla, iKOVES omd YATESD TOO0GPAIPOV, ALPYOLOAOYIKOVG
YOPOLS, UEPN TOAe®V Kol pall Yvootég peAmdiec, cvvBétovv maryvidla mov e&ttdpouvv
TNV QOVTAGI0 KO TPOGPEPOVY EUTELPIEG PEAAIOTIKEG GTOVG YPNOTES TOVG
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6.9 Xvunepaopata

Kébe @opd mov Eexvape po epyacio €va otdyo amd v apyn oniadn oamd Tov
oxeSGHO TNV AVAALGN TNV EKTEAECT] TNV JEKTEPAIMOT) PTAVOLLE GLYVA GE GNUELD VO
OVOAOYIGTOVLE KOl VO OKEPTOVUE Tow Oo MTav T YPCULO GUUTEPACUATO DOTE VO
Bonnbovpe nepiocdtepo 660 aPopd KATowo PEATIOOTN GE EXOUEVN LOG EPYACIOL 1 Vi VO
dophmdcovpe TV 1o vdpyovsa. Eivar Aoyikd va KATGOLE KOt VO LEAETTCOVUE L0l TIG
Kivnong g omoiog KAvVOUE Prpo Yo Vo QTAGOVE OTNV OAOKANPMOT| TNG EPYOGIOG LLOG
Vo TPOGOLOPICOVUE TL HOG OLOKOAEYE TOV E0OEWOE TEPIGGOTEPO YPOVO KO TL HOG
BonBnoce teMKd Y10 Vo TO ETAVGOVLE.

Oco apopa TOPO TNV GLYKPLLEVT] TTTVYIOKN TO HOVO Giyoupo cuumépacua givor Ott
{Moape por ToAD gvyaploTn eUTEPiCt KOL GLVOLAGAUE TO GeEVAPLO TNV oKnvobecia 1o
HOVTAC e oL To Yyneakn TPOGEYYIoT TAVe otV onoia po forinoe to avrikeipevo g
OYOMG HaG, To TOAVUESH. ATO €0® Kol GTO €ENG UTOPOVUE VO GTCOVUE UE OPKETEG
aELDGELS £vOL OAOKANPOUEVO YNOLokO HovTal To 6moto dev Ba £xet Timota va nAéyet omd
To emayyeApaTikd povtal kou emeEepyaciog Pivteo. Mropotpe edkora AoV va TovuE
OTL T0 KOPLO CLUUTEPAGHO TNG CLYKEKPIUEVIG TTUYLOKNG €ivan n TOAN peYdAn eumelpio
OV TNPOLE GE OAO TO QPAGHO TOL YNPLAKOL HOVTAL OAAG Kot YEVIKOTEPES YVADOELS TAV®
010 oegvdplo v oknvobecia mov oA NTaV OAANAEVOETA peTald Tovg Yo £va GOGTO
amoTéAeco Mmopope TAEOV Vo £XOVUE Lo KOADTEPT EIKOVA TAV® GTNV ENeEEPyOcia
Bivteo pHEC® ETOIU®V TOAVPACIKOV EPAPUOYDOV OTMOS EMIONG EIKOVOAS Kot TITA®V Kabdg
Ko emeepyaciog oV e aVAAOYES EPUPUOYES TTANPOPOPIKNG.

6.10 MelhovTikég gpyaoieg

dvowka timota dev TEAEU®VEL PE TNV CLYKEKPLUEVT gpyacio av BElovpe va Aépe OTL
eEEMOCOLOOTE TAV® TNV EWOIKOTNTO LOG KOL VO £XOVE TPOOTTIKY] MOTE VO LWTOPEGOVLLE
Vo EYOVUE U0 ETAYYEALOTIKY GTASI00pOLio 1oV o LTopEGEL Vo KaBlepmGEL TIG YVMOOELG
pog oe éva kado emmedo. Ilpenel va mwhvta va gipoocte aviovyol Kot vo BAETovUE o€
HEALOVTIKEG epyacieg péaa amd Tig omoieg Oa emTHyov e KATL TETO0.

Mo peAdovtikn epyacio n omoia givol oto TAOVA LG Elval po TOAVQAGIKY| TOpAymYN
Kot TAA e TNV dopn €vOC VIOKIHOVTEP Alyo dtapopetikn Pefaio and v mponyovpevn.
Meca Aowmdv ota dueca oxedia givar n Aym Pivteo amd dtapopég dStaonpeg TAATEEG TG
Evpdnng o1 aviyvevon otoryeiov yuo avtég péca and ta&idto ta omoio Ba yivouv o va
TOPOVCLOOTEL [l OVAOPOUY OE OLTEC KOl OTOL CNUAVTIKOTEPO YEYOVOTO, TO. OTOio
ovvefnoav. Emong Ba avaxoidyovpe toug AOYoug Tovg 0moiovg dnpovpyndnkay, amod
EMNPOVE TO OVOLATOVG,TLG SIUGTACELS KOl TV WO10LOPQia TOVG.

Oa g16dyovpe KovoOpylo OTOLKED PHEGH OT®G £lval aPNYNoN OAAL KOl TOALY TEXVIKA
OTOEW HECH OO TNV EQPOPUOYN MOTE VO UTOPEGOVUE VO OMGOVLUE £VaL UKL KON
KOADTEPT PON DOOTE 1) TAPAKOAOVLONGN TOL va gival EvOPEPOLGA KOt v UV Kovpdalet
tov Oegom.Ta epyoreion pe T omoie Oa tO0 Swrehécovpe eivor  QLOIKA
KOUEPES, KPOP®VOL,,TPUTOdES KaODS Kot amd avOpdmivo duvapkd €va 11 6vo dtopa to
omoia Ba Ta&edovv Kot o apnyovvtar Bo epmTAVE VIOTIONG KOTOIKOVG GYETIKG LUE TIG
mhotelég ko Ba TEpvoUV ouvevTELEELG.O1 TOAPOOIKES  €PapUOYEG Ol omoieg Bar pog
Bonbnoovv nave oto povtdl Ba eivar puokd Tpoypappata editing videogreEepyasiog
NYOV OAAG KO EIKOVOG.
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